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 DOWNLOADABLE CONTENT 
Whenever you see this symbol at the end of an article, it means 
there are either downloadable practice files or additional content 
for KelbyOne members at http://kelbyone.com/magazine.

 Set Yourself Apart  
 from the Competition
Sticking with the business theme for this issue, Frank Salas 
gives some great advice on things you can do or offer to separate 
yourself from your competition.

Frank Salas

 Managing Photo Shoots
Rafael “RC” Concepcion sat down with Lynn DelMastro, studio 
manager and producer for Joe McNally, to discuss all the things 
a photographer needs to consider when planning various photo 
shoots, from budgeting time and money to usage rights.

Rafael “RC” Concepcion & Lynn DelMastro
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� KEY CONCEPTS 
These icons at the beginning of columns indicate there’s a short video on a tool 
or function used in that tutorial at the Key Concepts KelbyOne member webpage 

at http://kelbyone.com/keyconcepts.
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	 Engraver III

101	 Perfectly Clear 2 
	 Perfect Photo Suite 9 Premium
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105	 Photoshop Book Reviews

But Wait— There’s More

 Developing a Business Plan
This issue, we’re all business. It’s the beginning of the new year, 
so there’s no time like the present to tackle your business plan. 
Tamara Lackey discusses all the reasons why it’s so important to 
have a plan, and how it impacts every aspect of your business. The 
toughest part is getting started, but don’t worry, Tamara even has 
a plan for that.

Tamara Lackey
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As we’re headed into the new year, I want to make sure you get the most from this magazine and your KelbyOne membership in 
2015. So what’s coming in 2015? A whole lot more of everything! It sounds like I’m joking, but that’s the plan. 

Our goal has always been to release one full-length class for our members every Thursday. That’s 52 classes a year. As we close 
out 2014, we’re on pace to deliver almost double that. That’s an insane amount of classes. Next year, we’re looking at new features 
being added to Photoshop on a regular basis through the Creative Cloud, and if Adobe updates Lightroom, we’ll be the first with 
classes on it and with full coverage here in the magazine. 

Of course, a lot of our members are photographers and we’re going to crush it for them with lots of new classes on both ends 
of the experience spectrum, which means more new classes for beginners on everything from photography to Lightroom and more 
advanced classes with some amazing new instructors being added to the lineup this year, as well.

Two of the most underutilized benefits for our members are tech support for Photoshop, Lightroom, and photography and the 
awesome discounts we’ve negotiated on all sorts of products and services exclusively for members. The members who use these two 
services absolutely rave about them, but I don’t think nearly enough members take advantage of either.  

The tech support alone is pretty unique in our industry. Think about it. You’re working on a Photoshop project or you’re working 
in Lightroom and you have a troubleshooting problem, or maybe you don’t know how to create a specific effect or look. Maybe your 
camera’s acting up. Whatever it is, we have private, one-on-one, direct tech support to help you through it fast, and that’s something 
we’re really proud of. 

As for the discounts, we’ve built up a huge collection of companies that offer our members exclusive deals, and we hear from 
members all the time who pay for their memberships with the discounts alone. We even have some discounts that fly under the radar, 
such as our discount Apple Store, created for us by Apple themselves. I saved more than $200 on my laptop versus the regular Apple 
Store price, so it’s a pretty sweet benefit. Give both of those a try and it will add even more value to your membership. 

The brand-new KelbyOne member site looks really nice. The reason for the new site is that we wanted to implement a massive 
technology update under the hood, and it started with a new enterprise-level video player that delivers a better video experience all 
around. Beyond that, we were able to bring one of the features we’ve wanted to add for a long time: closed captioning. We also 
snuck another great feature in that I think you’ll love: searchable transcripts. You can search every word said in every class, so if there’s 
a particular technique you need to search for, you can pinpoint exactly where it is, and that’s a huge time saver. 

We always want to make the site easier to navigate and more functional. Nobody has time to go digging around struggling to find 
out what they want. It’s about getting them to the training they’re looking for fast, and we’ve made great strides in this area. Look 
for lots more improvements and a better Web experience all around. I’ve seen some of the things we’re working on, and it’s some 
pretty smart stuff that I can’t wait to share.  

Finally, we released the KelbyOne app for Android users (yay!) and we added a feature to the iOS version: the ability to take up to 
three classes offline so you can watch classes any place where you don’t have access to the Internet.

I’m sure you’ve heard that Matt Kloskowski joined onOne Software, but we still have a great relationship and we’ll be working with 
him going forward. While I won’t see him every day in the office, you’ll still have the opportunity to learn from him at KelbyOne in 2015. 

Here in the magazine, you’ll see more of the tutorials and articles you’ve told us you wanted (thanks for everybody who took our 
survey). Our goal is to make sure that nobody knows more about Photoshop and Lightroom than you. It’s going to be an awesome 
year, and I’m so glad to have you with us on this journey. 

Here’s wishing you a 2015 filled with health, happiness, and prosperity. 

 All my best,

Scott Kelby
KelbyOne President & CEO
Editor & Publisher, Photoshop User

From the Editor
 great things coming in 2015
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Photo Panel Display

Simply ElegantTM Photo Panel Displays might be your favortie new product of  the year. This 
vetsatile, adaptable, high-quality display mount is priced right and perfect to have on hand for 
quick photo and sign display or professional installations.  Sizes up to 11 x 14” .

COMPATIBLE SUBSTRATES (with the adhesive face)
Most any  cotton, photo or poly-based � lms and papers
Lightweight fabrics
Various up-cycled materials

RECOMMENDED APPLICATIONS
Photo Display, Retail and Point-of-Sale, Museum Signage, 
Environmental Way� nding, In-house Graphics, Awards, 
Craft and Hobby, Art Display, Trade Shows, Gifting,  Pre-
sentation, Contests, Cluster Displays and Decor.

INSTRUCTION VIDEO   visit www.itsupplies.com

Simply Elegant  Photo Panel Display 1” Depth

SKU pack Size Price
SECQ131920 1 5 x 7” $    8.99 
SECQ172220 1 8 x 10”      11.99
SECQ17R100 1 11 x 14”     16.99
SECQ24R100 10 5 x 7”       79.99
SECQ36R100 10 8 x 10”    109.99
SECQ44R100 10 11 x 14”    154.99

Easy to wall-mount, 
with one push pin, 
or use the included 
‘kickstand easel’ for 
desktop display.

high quality     professional appearance    easy to use      multiple applications

{ {
Finished, trimmed image size is as follows:
5 x 7” =  4.7 x 6.7”        8 x 10” =7.7” x 9.7”       11 x 14” = 10.7 x 13.7”

 Print your image
 Trim to size
 Remove release liner
 Position and stick
 Display solo or 
         as a grouping

www.itsupplies.com
(800) 771-9665Free Shipping*, Best Prices, Friendly, Knowledgeable Service.

*free ground shipping on orders over $99

Epson    Canon    HP    Hahnemuhle    MOAB    Premier 
Imaging    ClearStar    Harman   ONYX   InkJet Art    Inkpress    

Museo    X-rite    Kodak    Photo-tex    Simply Elegant 
Innova    Ricoh   Geo Knight    Chromaluxe   Wasatch

New Gear for
the New Year!

Dye-Sublimation
Starter Systems

Call today to learn MORE!

Simply Elegant
Metallic Canvas

Simply Elegant
Photo Panels

Simply Elegant
Gold Fiber 310

mailto:publicpsu@kelbymediagroup.com
mailto:letters@photoshopuser.com
mailto:info@photoshopuser.com
http://members.photoshopuser.com
https://www.itsupplies.com
http://www.fjwestcott.com/power
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KEVIN AMES 
creates photographs for clients such as Westin Hotels, AT&T, and Coca-Cola. He has 

authored four books, including a Dummies book, and his photos have appeared in 
Time, Newsweek, and The Wall Street Journal. Visit kevinamesphotography.com.

 PETER BAUER 
is an Adobe Certified Expert that does computer graphics consulting for a select  

group of corporate clients. His latest book is Photoshop CC for Dummies. He was 
inducted into the Photoshop Hall of Fame in 2010.

PETE COLLINS 
is an education and curriculum developer and website overseer for KelbyOne. He is one 
of the Photoshop Guys and co-hosts Photoshop User TV. With a fine arts background, 

Pete is well versed in photography, graphic design, and illustration.

RAFAEL “RC” CONCEPCION 
is an education and curriculum developer for KelbyOne. An Adobe Certified Instructor 
in Photoshop, Illustrator, and Lightroom, RC has 10+ years in the I.T. and ecommerce 

industries. RC has held training seminars in the U.S., Europe, and Latin America.

MICHAEL CORSENTINO 
is an award-winning wedding and portrait photographer, Photoshop and Lightroom 

expert, author, columnist for Shutter Magazine and Resource Magazine, and speaker and 
international workshop leader. Learn more at www.michaelcorsentino.com. 

SEÁN DUGGAN 
is the co-author of Photoshop Masking & Compositing, Real World Digital 

Photography, and The Creative Digital Darkroom. He leads workshops on digital 
photography, Photoshop, and Lightroom (SeanDuggan.com).

DANIEL EAST 
is an author, freelance writer, presenter/trainer, and consultant with more than 20 years’ 

experience in photography, pro-audio, and marketing. Daniel is also founder and president 
of The Apple Groups Team support network for user groups.

ROD HARLAN 
is an industry veteran with 25 years’ experience as an author, educator, photographer, 

multimedia artist, and Photoshop addict! He shares content at RodHarlan 
.com and is a trainer for Adobe, NAB, FMC, WEVA, and KelbyOne, among others. 

MARK S. JOHNSON 
is a Photoshop luminary, a longtime contributor to the NAPP and Planet Photoshop  

sites, a member of Dewitt Jones’ Healing Images campaign, and a Trey Ratcliff  
Flatbooks author. For more, visit www.msjphotography.com. 

TAMARA LACKEY 
is a Nikon USA Ambassador whose work has been seen in O, The Oprah Magazine and  
on the Today Show. She’s the host of the reDefine show and author of several books in-

cluding Capturing Life Through (Better) Photography. For more, visit tamaralackey.com.

JESSICA MALDONADO 
has been art director of books at KelbyOne for more than eight years, has created  

video tutorials for LayersMagazine.com and reviews for Photoshop User magazine,  
and co-hosted Photoshop User TV in 2013.

SEAN McCORMACK 
is the author of Essential Development: 20 Great Techniques for Lightroom 5.  
Based in Galway, Ireland, he shoots subjects from musicians, models, and actors  
to landscapes and architecture. Learn more at http://lightroom-blog.com. 

JAY NELSON 
is the publisher of The Skinny Book series of eBooks (theskinnybooks.com) and former 
publisher of Design Tools Monthly. He knows a lot about digital publishing, fonts, and 
font management. Find him on Twitter @jaynelson. 

FRANK SALAS 
has been named one of the top wedding photographers in the world, and is recognized 
as a Master Photographer and a Photographic Craftsmen by PPA. He is also a frequent 
speaker at conferences. For more on Frank, visit www.franksalas.com.

COLIN SMITH 
is an award-winning digital artist, photographer, and lecturer who has authored  
18 books and has created a series of training videos. Colin is also the founder of  
the online resource PhotoshopCAFE.com and president of Software-Cinema.com.

LESA SNIDER 
is the author of Photoshop CC: The Missing Manual, several eBooks, and video  
courses, as well as co-author of iPhoto: The Missing Manual. She’s also a columnist for 
Macworld and Photographic Elements Techniques. For more info, visit PhotoLesa.com.

ROB SYLVAN 
is the Lightroom Help Desk Specialist for KelbyOne, on staff at the Digital Photo  
Workshops, and the author of Lightroom 5: Streamlining Your Digital Photography 
Process. You can learn more at www.lightroomers.com.

SCOTT VALENTINE 
is an Adobe Community Professional and Photoshop author. His latest book  
is The Hidden Power of Adjustment Layers (Adobe Press). Keep up with him  
at scoxel.com.

ERIK VALIND 
is a New York City-based commercial photographer who shares his knowledge in 
various publications, as an author, online as a KelbyOne instructor, as well as through 
workshops and seminars across the country. Visit www.ErikValind.com.

ERIK VLIETINCK 
founded IT Enquirer in 1999 (http://it-enquirer.com). A J.D. by education, Erik  
has been a freelance technology editor for more than 20 years. He has written  
for Macworld, Computer Arts, Windows NT Magazine, and many others. 

JAKE WIDMAN 
is a writer and editor who lives in San Francisco. He’s been covering the intersection  
of computers and graphic design for about 25 years now—since back when it was 
called “desktop publishing” and Photoshop was just a piece of scanning software.

P H O T O S H O P ’ S  M O S T  W A N T E D   ›  ›
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Photoshop User 
Magazine
Photoshop User magazine is the official publication of 
KelbyOne. It is for members and is not available to the 
public by subscription.

As a KelbyOne member, you automatically receive  
Photoshop User delivered right to your door (or digi-
tally) ten times a year. Each issue features in-depth 
Photoshop, Lightroom, and photography tutorials writ-
ten by the most talented designers, photographers, and 
leading authors in the industry.

KELBYONE 
is the world’s leading resource for Adobe® Photoshop®, Lightroom®, and 

photography training, news, and education. Founded in 1998 as the National 
Association of Photoshop Professionals (NAPP), KelbyOne has evolved from 

NAPP and KelbyTraining to create a singular hub for creative people to learn, grow, 
and inspire. From photographers to graphic designers, beginners to professionals, 

KelbyOne is open to everyone.    

There’s no faster, easier, and more affordable way to get really good at Photoshop 
and photography. You can join for only $25 per month or $249 U.S. for a full year 

of training. To learn more, visit www.kelbyone.com.

 

	

PHOTOSHOP USER MAGAZINE 
Ten issues of the best Photoshop tutorial-based magazine in the industry.  

MEMBERS-ONLY WEBSITE 
Our extensive website features time- and money-saving content.

ONLINE CLASSES & EDUCATION 
Thousands of Photoshop and photography tutorials, full online classes,  

and quick-tip videos. 

MEMBER DISCOUNTS 
Save anywhere from 2–4 times your membership cost by using our many 
industry-related discounts.

TECH SUPPORT 
Fast, friendly Photoshop, Lightroom, and photo gear help; equipment 
advice; and more from certified experts.

MEMBER COMMUNITY 
KelbyOne members range from beginners to pros and love to lend each 
other a hand. Together, we have built the friendliest, most knowledgeable 
Photoshop and photography community on the Web.

NEWS & REVIEWS 
Unbiased coverage on the latest equipment, plug-ins, and programs 
in the marketplace.

WEEKLY E-NEWSLETTER 
The KelbyOne Insider is your weekly connection to everything KelbyOne.  
It’s produced exclusively for members to keep you informed of everything 
new in the industry and at KelbyOne headquarters.

REGISTRATION DISCOUNT 
TO PHOTOSHOP WORLD 
CONFERENCE & EXPO 
The annual KelbyOne convention and the largest Photoshop and  
photography learning experience on the planet. It’s an amazing event.

FIND KELBYONE MEMBERSHIP DETAILS AT   or call 800-738-8513 Monday–Friday, 9:00 a.m. to 5:30 p.m. EST.

About KelbyOne

Member Benefits

www.kelbyone.com
http://www.manfrotto.us
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An Epic African Safari   
coming to a kelbyone class soon
A Moose and a videographer embark on an African safari…. Yeah, there’s no punch line here, except the entertaining and ridicu-

lously cool batch of selfies we received from our very own video director, Adam Rohrmann, after his epic safari with Moose Peter-

son. While selfies with the critters was an extracurricular 

assignment and an added bonus for our entertainment, 

Moose and Adam were on a serious mission to create 

one kick-butt KelbyOne class. 

Our objective is always to bring our members as close 

to the action as possible, so we knew this adventure 

would turn into much more than just another class. This 

unforgettable journey allowed these two passionate cre-

atives to see Africa in a spectacular way and create some-

thing much more than a class on wildlife or travel pho-

tography. While Africa is rich in wildlife diversity, it’s also 

in grave danger. The extremely high risks of extinction 

and poaching added more meaning to every picture they 

captured, to the point where all EXIF data is scrubbed 

from every photo taken of a rhino. 

Adam gained a life-changing perspective from knowl-

edgeable rangers who provided a ton of valuable infor-

mation on the animals and their habits. This knowledge 

was key to helping create a story in this class, to give 

that extra meaning to every piece of footage Adam and 

Moose captured. Right down to Adam dropping his cam-

era to seek safety before being run down by three rhinos 

(don’t worry, no one was harmed in the making of this class). 

This adventure put Adam and Moose in close and personal (and dangerous!) situations with the wildlife, which is sure to provide 

tons of amazing teachable moments. Based on the stories and behind-the-scenes images we’ve seen so far, this is a class you won’t 

want to miss. Get a sneak peek of the adventure on Moose’s blog at Moosepeterson.com, including Adam’s infamous selfies. Be 

sure to keep an eye out for this class coming soon in 2015.

Correction
In the December issue of Photoshop User magazine, we included group photos from Scott Kelby’s 7th Annual World-

wide Photo Walk on page 14. In our haste to ship that issue off to press, we inadvertently left off the photo credits for 

those images. Our apologies to Andy McSweeney (left) and Mohamed Mekhamer (right). To see more of Andy and 

Mohamed’s work, check out the opposite page and then visit their websites.

ARTIST SPOTLIGHT ›  ›  ANDY McSWEENEY AS PHOTO TOUR BRUGGE 
MEMBER SINCE 2014 | MAIN IMAGE FOR PHOTO TOUR BRUGGE 
WWW.PHOTOTOURBRUGGE.COM   

ARTIST SPOTLIGHT ›  ›  KEVIN GRAHAM 
MEMBER SINCE 2009 | WWW.DSWFOTO.COM
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ARTIST SPOTLIGHT ›  ›  JIM ORME 
MEMBER SINCE 2013 | HTTP://JANDKIMAGES.PHOTOSHELTER.COM  
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ARTIST SPOTLIGHT ›  ›  MOHAMED MEKHAMER  
MEMBER SINCE 2013 | EGYPTIAN REVOLUTION OF 2011: FIRST 
PLACE IN NIKON I AM A MOVEMENT PHOTO CONTEST 
WWW.MEKHAMER.COM
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http://JANDKIMAGES.PHOTOSHELTER.COM
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ARTIST SPOTLIGHT ›  ›  STACY TUGGLE 
MEMBER SINCE 2011 | HTTP://3HEARTSPHOTO.COM 

ARTIST SPOTLIGHT ›  ›  JEREMY ZABOROWSKI 
MEMBER SINCE 2014 | WWW.ZABOROWSKIPHOTO.COM

Fresh New Classes
released at kelbyone.com  
Photoshop In-Depth: Lighting Effects

The Lighting Effects filter is an incredibly powerful filter that 

can be used for relighting an existing photograph in myriad 

creative ways. From the basics of the interface to workflow 

tips and tricks to advanced projects like changing day to night, 

Pete Collins shows you everything you need to know about 

Lighting Effects to start using it in your next project.

KelbyOne: 
a look at 2014
Where did 2014 go? While it may have gone fast, we cer-

tainly experienced some exciting events, changes, and creative 

moments that made this past year one of our best yet to be a 

member. Let’s take a short trip down not-so-distant memory 

lane at a few of our highlights here in the KelbyOne community. 

 

NAPP + KelbyTraining = KelbyOne 

Perhaps the biggest and most exciting news to come out of 

2014 was the joining of forces between NAPP and KelbyTrain-

ing. Joining forces to create a singular resource, KelbyOne 

gave members even more amazing benefits than ever before. 

The combined catalog of classes has made our online train-

ing limitless, and our already strong communities grow even 

stronger with inspiration. 

Brand Spankin’ New Website

In October 2014, we launched a fresh, new website that makes 

navigating your online training resource a breeze. We added 

features like a better video player to enhance your training, a 

smoother checkout when making those must-have purchases, 

and, of course, a facelift that’s easier on the eyes. 

New Classes Released Every Week 

We take pride in making sure we push out quality content 

that’s current and covers the topics you want to learn. In 2014, 

we released more than 80 new classes from the industry’s 

leading experts. That’s nearly two classes a week for your give-

me-more-coffee cram sessions. 

KelbyOne World Tour

Okay, maybe it wasn’t quite a world tour, but Scott did jump 

across the pond to visit our friends over in the U.K. for his 

“Shoot Like a Pro Seminar Tour.” Plus, we held more than 

51 one-day training seminars in the U.S., with nearly 12,000 

eager, creative, photography-loving attendees. 

We Be Bloggin’

We created a KelbyOne blog (www.kelbyone.com/blog) to 

up our cool points with the cyber hipsters, but also to deliver 

the very latest trends in Photoshop, Lightroom, photography, 

design, and video. It’s packed with tons of great articles, tutori-

als, and news from our instructors and other industry insiders. 

Photoshop User Redesign 

This one is just checking to see if you’re paying attention. If 

you still have that sparkle in your eye for your favorite Photo

shop magazine, then surely you noticed a little redesign to 

incorporate our new KelbyOne branding, plus some extra 

design elements brought over from our Light It and Light-

room apps for added enhancement. 

That’s just a snippet of cool stuff we saw during another 

year that flew right past us. We have even more in store for 

2015, so ready those cameras because we’re sure to be in 

for another picture-perfect ride! (You can read more about 

what’s in store for 2015 in Scott Kelby’s “From the Editor” 

on page 6.)

Photoshop In-Depth: Cropping and Resolution

Image cropping and resolution are two of the most com-

monly misunderstood aspects of a digital imaging workflow. 

Join Pete Collins as he explains the principles you need to 

understand when cropping, resizing, and preparing your 

images for output so you can maintain the highest image 

quality possible for any job that comes your way.

Creative Speed Lighting for Fashion, Glamour, and Beauty

Join the amazingly talented Lou Freeman as she shares the 

wisdom gained from three decades worth of fashion, glam-

our, and beauty photography to show you how creative you 

can get with flashes on location and in the studio. 

DSLR Filmmaking: 25 Tips in Premiere Pro 

If you have a firm foundation for editing with Premiere Pro, 

then it’s time to up your game. Brandon Ford’s 25 tips, 

tricks, and hints are designed to make your editing workflow 

smoother, faster, and more efficient. He covers all of the little 

tricks of the trade that can add up to a huge savings in time 

when editing a big project. 

http://3heartsphoto.com
WWW.zaborowskiphoto.com
kelbyone.com
www.kelbyone.com/blog
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Who's Who 
	 in the kelbyone community

Meet Susan L. DeLuca, long-time member, senior executive 

turned photographer, and recent Image of the Week pick 

from Pete Collins. Her whimsical Fairy by the Water image 

wings its way into our hearts with its perfectly executed 

magical and mystical theme. Let’s take a look inside what 

keeps Susan’s creative fire burning.

Tell us a little about the work that went into Fairy by 

the Water. 

Everything is done in Photoshop. I make sure the lighting has 

a lot of contrast, use actions from Chasing Light, and then 

hand touch-up in Photoshop. Each one of my pictures takes 

me 12–15 hours at a minimum to complete. My most recent 

picture, Walk in Mystery, actually took me close to 30 hours 

to complete.

How has KelbyOne helped keep your training mov-

ing forward?

I have been to your conferences, studied online using your 

classes, and have numerous books you have published. Kelby

One has been my greatest source of nonuniversity informa-

tion and education. 

What’s one of the most helpful tips or lessons 

you’ve received?  

“Your lighting is terrible!” I admit I still need more experience 

in this area, but I’m getting better. 

If you could pick anyone (living or dead) to be your men-

tor, who would it be? 

Mathew Brady, Civil War photographer. 

Time travel is possible and you can photograph any 

event. Name it.  

I would have loved to photograph out west at the time of 

the settlers and be able to use the style of photography (with 

Photoshop, of course) that I use now. 

You have the winning lotto numbers in hand, what’s 

your first purchase?  

If I actually did win the lottery, I would use every penny to 

build a photography school, gallery, and studio that could 

be shared with the community and local schools, which has 

been a dream of mine. 

Keep those dreams alive, Susan. We’re diggin’ it! Check out more 

of Susan’s work at www.bloomingdalephotography.com.
Susan L. DeLuca

Spread the
good word

Teaching is our passion. It’s in everything we do. And hearing 

your success validates the very reason why we’re here. So preach 

on about the good word. We’re all ears. 

“@ScottKelby @kelbyone By the way, your Photo Recipes book 

is superb! I’ve already learned a lot and will be buying rest of the 

series soon!”—@MochrumDunbar

“KelbyOne has really upped their game with all the great  

in-depth training videos.”—Steve H.

“Photoshop User is my go-to magazine for information. Love 

it!”—Marilyn M. ■

www.bloomingdalephotography.com
http://www.portraitprofessional.com
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BY MIKE MACKENZIE AND CHRIS MAIN

 ›  ›  e x p o s e d :  i n d u st r y  n e w s

Lenovo Announces  
thinkpad 550s mobile workstation
The new ThinkPad 550s Mobile Workstation blends the 

compact size of an Ultrabook with the processing power of a 

mobile workstation. At the heart of the 550s is a 5th genera-

tion Intel Core i7 Dual Core processor and an NVIDIA Quadro 

K620M graphics card with 2GB of GPU memory. Up to a 1-TB 

HDD or 512-GB SSD is available, and it can accommodate up to 

16 GB of RAM. 

The ThinkPad 550s includes an integrated 4-in-1 media card 

reader and the following ports: one VGA, one mDP v1.2, three 

USB 3 (one always-on charging), one mic/headphone combo 

jack, one RJ45 gigabit Ethernet, one docking connector, and 

a smart card reader is optional. Three display options are 

available: a 1920x1080 Full HD, a 2880x1620 3k, or a 

2880x1620 3k touch. 

As of this writing, pricing and availability is not 

known. For complete specifications and options, 

visit www.lenovo.com.

DxO Unveils   
	 filmpack 5

FilmPack 5 Elite Edition from DxO Labs emulates the style, colors, 

and grain of more than 80 analog films, plus roughly 40 more cre-

ative styles. FilmPack 5 has a redesigned interface to make it easier 

to use. Included are designer presets and advanced settings, such 

as Hue/Saturation/Luminance, Tone Curve, Vibrancy, and more 

that allow you to fine-tune your photos. It can be used as a stand-

alone app or as a plug-in with Adobe Photoshop, Lightroom, and 

DxO OpticsPro. Support is offered for RAW, JPEG, and TIFF formats. 

FilmPack 5 Elite Edition is available now for $129. DxO also 

offers a pared-down Essential Edition version for amateur photo

graphers that has fewer films and filters, no RAW support, and 

fewer controls. The Essential Edition costs $79. For more informa-

tion, visit www.dxo.com.

.

Exp  sed: Industry News
The latest news about photography gear, software, and services›  ›

Tiffen Updates Their  
dfx digital filter suite
Tiffen recently released version 4 of their popular digital filter suite, Dfx. This plug-in package replicates Tiffen optical filters, Rosco and 

Gam gobos and gels, and hundreds of photographic film stocks. Version 4 comes in several versions, including a film/video plug-in 

($499.95) that works with popular video applications, such as Adobe After Effects and Premiere Pro; a photo plug-in ($149.99) that 

works with Photoshop and Lightroom; and a standalone version ($129.99) that works with JPEGs, TIFFs, and RAW files without a 

host application.

Dfx 4 includes 12 new filters ranging from Cartoon to Grunge to Pearlescent. New presets include 93 historical film processes 

and 30 motion picture film stocks. There are also new tools for color correction, tint enhancement, and gradient control. The ability 

to process in 32-bit floating point precision allows selective access to your image’s dynamic range without clipping. The photo and 

standalone versions offer improved and faster masking tools and a new Curve tool. The combination of an improved interface and 

GPU acceleration using OpenCL provides for a much faster workflow throughout all the versions of Dfx.

There are also Dfx 4 OFX Pro ($999.95) and Standard versions ($499.95). These versions add OFX plug-in support, which means 

it will run in professional intermediate programs such as Blackmagic Design Davinci Resolve. For more information about each ver-

sion of Dfx 4, visit http://software.tiffen.com. ■

VideoBlocks Stock Video Marketplace  
allows contributors to keep 100% of their sales
Recently, VideoBlocks announced the launch of a stock video marketplace that allows content creators to keep 100% of the pro-

ceeds from their sales. This new marketplace will work alongside VideoBlocks’ existing subscription model.

Subscription members have access to a library of more than 100,000 premium, royalty-free stock video clips, motion back-

grounds, and After Effects templates. According to VideoBlocks, because contributors keep 100% of the proceeds, they can offer 

significantly lower prices than their competitors. 

For more information about VideoBlocks’ subscriptions or to apply to become a contributor, visit www.videoblocks.com.

Westcott Releases  
new softbox, reflector, and inverter
Westcott (www.fjwestcott.com) recently introduced the 32" Rapid Box Octa Duo, an ultraportable softbox that allows photogra-

phers to mount up to two hot-shoe flashes. It features a highly reflective silver interior, umbrella-style frame, lightweight construction, 

and it comes with a travel case. The built-in solid metal mounting and tilting bracket is fully adjustable and accommodates even the 

largest flashes. An adjustable collar prevents light spill while still allowing access to flash controls. An optional deflector plate and 

grids are available. It’s available now for $269.90.

The 38x45" Omega Reflector is a 10-in-1 shoot-through reflector that also functions as a beauty dish and ring flash. It produces 

a main light and backlight with a single light source while keeping the reflector out of the frame. The Omega Reflector features a 

one-stop diffusion panel with an interchangeable white, silver, sunlight, and black cover. It has a double-riveted square frame for 

easy mounting, and also includes suction cups to mount it to glass surfaces. A travel bag is also included. The Omega Reflector 

costs $99.90.

The Encore Inverter is designed to power monoblocks, LEDs, constant lights, and it 

can charge mobile devices. At the heart of the Encore Inverter is the latest li-ion 

technology, producing 3 full amps of charging power and a continuous 

200-W output with a 2-second recycle time. According to Westcott, 

that’s the equivalent of 800 full-power flashes when using a 300 

Ws strobe. It has a dual-plug system, all-metal housing to pro-

tect the battery, and it weighs less than 5 lbs. The extruded 

aluminum shell reduces heat, providing a longer lifespan for 

the system and the removable battery. A carrying case is 

included. Additional batteries are available. The Encore 

Inverter sells for $299.90. 

www.lenovo.com
www.dxo.com
http://software.tiffen.com
www.videoblocks.com
www.fjwestcott.com
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Dirty
Tricks

This was inspired by a magazine ad I saw recently for the new 
Michael Jackson show in Las Vegas. It had a very interesting color 
effect and illustrated style. After some experimenting I stumbled 
upon a very interesting series of steps to achieve a similar look on 
a photo. Enjoy! 

light & color f/x 
B Y  C O R E Y  B A R K E R

Step One: Begin by opening the download file or a file of your 

own. If you use your own image, make sure it has a dark back-

ground, or extract the subject from the background before you 

get started. The image I’m using works well because it’s fairly 

evenly lit and has a simple, dark background.

[KelbyOne members may download the file used in this tuto-

rial at http://kelbyone.com/magazine/issue/january . All files 

are for personal use only.]

Step Two: Press D to set the Foreground and Background 

colors to their default black and white, respectively. Choose 

Image>Adjustments>Gradient Map, and click OK in the Gradi-

ent Map dialog that appears. This will convert the image to black 

and white. This is one of many methods I use for a black-and-

white conversion. 

Step Three: Duplicate the Background layer by pressing 

Command-J (PC: Ctrl-J), then hide the duplicate layer (Layer 1)  

by clicking its Eye icon in the Layers panel. Now reselect the 

Background layer.

Step Four: Go to Filter>Blur>Surface Blur. This allows you to 

smooth areas without losing any edge detail. We set the Radius 

to 7 pixels and the Threshold to 7 levels. Click OK. 

Step Five: Now choose Filter>Artistic>Poster Edges. If you don’t 

see this, go to Filter>Filter Gallery and click on the Artistic folder 

to find the Poster Edges filter. Set the Edge Thickness to 0, Edge 

Intensity to 1, Posterization to 3, and click OK. This will give the 

image a more graphic look.

Step Six: Go to the Layers panel and click the empty square 

where the Eye icon was for Layer 1, then Shift-click Layer 1 to  

select both layers. Choose File>New to create a new document 

measuring 9x12" at 150 ppi, then press Option-Delete (PC: 

Alt-Backspace) to make the background black. Select the Move  

tool (V), then click-and-drag the two layers to the new docu-

ment. Remember to hold down the Shift key as you drag them 

over so the layers will be centered.
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Step One

Step Three

Step Five

Step Six

http://kelbyone.com/magazine/issue/january-2015
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Step Seven: Keeping both layers selected, press Command-T 

(PC: Ctrl-T) to invoke Free Transform, then press Command-0 

(PC: Ctrl-0) to expand the document boundaries to reveal the 

transform box. Move the cursor just outside the transform box 

and when you see the curved arrow, click-and-drag to rotate 

the image counter-clockwise. Now grab a corner handle, press-

and-hold Shift-Option (PC: Shift-Alt), and scale the image to fit 

in the composition, as shown here. Press Enter to commit the 

transformation. Be sure to keep both layers selected when doing 

this so they stay aligned.

Step Eight: Now once again turn off visibility for the duplicate 

layer (now Layer 2) and select the posterized layer (now Layer 1). 

Click the Create New Adjustment Layer icon (half-black, half-white 

circle) at the bottom of the Layers panel and choose Gradient Map. 

Click the gradient thumbnail in the Properties panel to access the 

Gradient Editor.

Step Nine: In the Gradient Editor 

that appears, click the gear icon in 

the upper right and choose Spec-

trums from the list. When prompted, 

click Append to add Spectrums to 

the existing list. Click the first preset 

in this set, which is called Spectrum. 

You’ll immediately see an interesting 

color effect applied to the image. 

Click OK. If the background isn’t a 

solid color, reselect the posterized 

layer (Layer 1), press Command-L 

(PC: Ctrl-L) for Levels, and drag the 

shadow Input Levels slider to the right until the color is solid.  

Click OK. 

Step Ten: In the Layers panel, change the blend mode of the Gra-

dient Map adjustment layer to Overlay. This drastically changes the 

color effect and is more in line with the warm color cast we’re 

looking for with this effect.

Step Eleven: Remember that 

duplicate layer? Let’s finally do 

something with it. Turn on the 

layer visibility and make sure it’s 

selected. Go to Filter>Blur>Surface 

Blur. Run the same settings we used 

earlier to smooth out the detail. 

Step Twelve: Now go to Filter>Stylize>Find Edges. This will basi-

cally create an outline of the image based on the edge detail. 

Now we need to do a subtle Levels adjustment to boost the over-

all contrast and darken the lines a bit more. Press Command-L 

(PC: Ctrl-L) to bring up the Levels dialog, and drag the shadow 

and highlight Input Levels sliders, as shown here. Click OK. 

Step Thirteen: Choose Image>Adjustments>Invert. This will flip 

the values around, making the lines white and the background 

black. In the Channels panel (Window>Channels), Command-

click (PC: Ctrl-click) the RGB composite channel thumbnail. This 

will load the luminosity or brightness of the image as an active 

selection, which is just the outline. Step Nine

Step Seven

Step Ten

Step Twelve

Step Thirteen
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Step Fourteen: With the selection 

active, click the Create a New Layer 

icon at the bottom of the Layers 

panel (Layer 3). With the new blank 

layer selected, press Shift-Delete (PC: 

Shift-Backspace) to open the Fill dia-

log. Choose White from the Contents 

menu, leave Mode set to Normal, the 

Opacity at 100%, and click OK. Press 

Command-D (PC: Ctrl-D) to deselect. 

Hide the visibility for Layer 2. Now 

drag this new layer (Layer 3) below 

the Gradient Map adjustment layer 

in the layer stack, then change the 

blend mode to Overlay. Select the 

Gradient Map layer and drop the Opacity to 90%. 

Step Fifteen: Select the posterized layer (Layer 1) and click the 

Add Layer Mask icon (circle in a square) to add a layer mask. 

Choose the Gradient tool (G) and, in the Options Bar, click on the 

gradient thumbnail. In the Gradient Editor dialog that appears, 

choose the Foreground to Transparent gradient, and click OK. 

Click the Radial Gradient icon in the Options Bar, and press X 

until the Foreground color is black. Now add random gradients 

around the layer mask to fade certain areas of the subject. As you 

do this, notice the gradient affects the color in interesting ways. 

The outline layer also emphasizes certain areas of the subject in 

a very stylish way. Continue to add more gradients in different 

areas. Be sure not to overdo it.

Step Sixteen: Now let’s add one more light effect. Click the Cre-

ate a New Layer icon, and choose the Elliptical Marquee tool (nested 

under the Rectangular Marquee tool [M]). Press Command- –  

(PC: Ctrl- –) to zoom out of the document, then drag out an over-

sized oval selection over the upper-left area of the image. Make 

sure the new blank layer is positioned under the adjustment layer. 

Step Seventeen: Select the Gradient tool and press D then X to 

set the Foreground color to white. Then start the gradient from 

the bottom-right corner of the document, and drag to the cen-

ter of the selection to introduce a subtle amount of white inside 

the selection. It will pick up the color of the adjustment layer 

and appear as a colored glare effect. We added a second gradi-

ent to the lower-right area, as well. When you’re done, press 

Command-D (PC: Ctrl-D) to deselect. 

Finally, we added a subtle bokeh effect in the background using 

a custom brush to enhance the overall colored-light effect. You 

can see how I did the bokeh effect in a special video supplement, 

which can be found at http://kelbyone.com/blog. ■ 

Step Seventeen

Step Fifteen

http://kelbyone.com/blog
http://www.topazlabs.com/mktg/psuser-lake.html


http://www.bayphoto.com
http://www.bayphoto.com/metalprints
http://www.bayphoto.com
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Tricks

You might be wondering how a bullet-riddled, bloodbath of a movie 
like John Wick could inspire a color-gel lighting effect. Was it the close 
quarters action sequences? Or the completely unrealistic gunfights that 
seemingly occurred every few seconds? Nope. It was one of the promo-
tional posters I saw after the fact. The color-gel light effect is simple and 
subtle. While adding a lit wick to the end of John’s tie is as clever as it is 
basic, it all blends together perfectly.

explosive color-gel light effect
B Y  F E L I X  N E L S O N
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Step One: Open a portrait 

image (preferably male) of 

someone wearing a suit jacket 

and tie. Click on the Create New 

Adjustment Layer icon (half-

black, half-white circle) at the 

bottom of the Layers panel and 

choose Hue/Saturation. This will 

add an adjustment layer above 

the Background layer in the 

Layers panel and also open the 

Properties panel showing the Hue/Saturation properties. Enter 

–33 in the Saturation field to lessen the overall image saturation.

	 [KelbyOne members may download the images used in 

this tutorial at http://kelbyone.com/magazine/issue/janu-

ary-2015. All images are for personal use only.]

Step Two: Click on the Cre-

ate New Adjustment Layer icon 

again and choose Levels. A new 

Levels adjustment layer will 

appear in the Layers panel, and 

the Properties panel will show 

the Levels properties. Enter 0.80 

in the midtone field.

Step Three: Click on the Fore-

ground color swatch at the bot-

tom of the Toolbox. Choose 

a bright light-blue color (R:30, 

G:192, B:255), and click OK to 

close the Color Picker. Add a 

new layer by clicking on the Cre-

ate a New Layer icon at the bot-

tom of the Layers panel (Layer 1).

Step Four: Choose the Gradient tool (G) from the Toolbox. In the 

Options Bar, click on the gradient thumbnail. When the Gradient 

Editor dialog appears, choose the Foreground to Transparent pre-

set, and click OK. Click the Linear Gradient icon (first on the left) 

in the Options Bar. Now click-and-drag a gradient from the center 

of his left eye to the center of his right eye (see example). Change 

the blend mode to Multiply in the Layers panel.

http://kelbyone.com/magazine/issue/january-2015
http://kelbyone.com/magazine/issue/january-2015
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Step Five: Create another 

new layer (Layer 2). Change 

the Foreground color swatch 

to a lavender color (R:122, 

G:112, B:184). In the Options 

Bar, choose the Reflected 

Gradient icon (the fourth icon 

from the left). Click-and-drag 

a gradient from the inside 

corner of his right eye to the 

outside of his right ear (see 

example). Change the layer 

blend mode to Overlay.

Step Six: Create another new 

layer (Layer 3). Press D to set the 

Foreground color to black. Press 

Option-Delete (PC: Alt-Backspace) 

to fill the entire layer with black. 

Click on the Add Layer Mask icon 

(circle in a square) at the bottom 

of the Layers panel. Choose the 

Brush tool (B) from the Toolbox. 

Using a soft-edged brush set to 

black (press D then X), paint to 

reveal areas around the face, col-

lar, and portion of the tie (see example).

Note: You’ll have to use smaller brush sizes to reveal por-

tions of the shirt, lapel, and tie. Use the Bracket keys on your 

keyboard to quickly change the size of your brush. Also reveal 

a slightly curved portion along the edge of the tie. If you reveal 

too much, press X to switch the Foreground color to white, 

and paint to hide those areas (you can also adjust the mask 

later if needed).

Step Seven: Create a new layer (Layer 4). Press X to switch 

the Foreground color to white. Using a small, soft-edged brush, 

paint a curve over the highlight on the tie, following the contour 

of the tie (see example). Change the layer blend mode to Over-

lay. This will enhance the existing highlight and will help create 

a more realistic effect when we add the fuse element.

Step Eight: Open an image that has a lit fuse on a black back-

ground. Using the selection tool of your choice (we used the 

Lasso tool [L]), make a loose selection around the fuse and 

sparks. Switch to the Move tool (V). Click-and-drag the selec-

tion into the original image (Layer 5). Press Command-Shift-U 

(PC: Ctrl-Shift-U) to desaturate the image (make it gray). 

Change the blend mode to Screen.

Step Nine: Press Command-T (PC: Ctrl-T) to bring up the Free 

Transform bounding box. Right-click inside the bounding box 

and choose Flip Vertical. Resize and reposition the fuse so that 

the unlit end aligns with the end of the tie highlight. Press 

Enter to apply the transformation.

Step Ten: Click on the Add 

Layer Mask icon at the bottom 

of the Layers panel. Choose 

the Gradient tool and click on 

the Linear Gradient icon in the 

Options Bar. Click-and-drag a 

gradient from the unlit end of 

the fuse toward the lit portion 

(see example).

Step Eleven: Go to Edit>Transform>Warp. Click-and-drag the 

lower-right corner of the top-left grid square toward the lower 

left to slightly bend the fuse (see example). Press Enter to apply 

the Warp. You may have to use the Move tool to realign the 

fuse layer (Layer 5) with the lower portion of the tie highlight.
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Step Twelve: Add a new layer (Layer 6). Press D then X to set the 

Foreground color to white. Choose the Brush tool. Using a soft-

edged brush, paint a white spot over the top of the burning fuse 

(see example). Change the blend mode to Overlay. 

Step Thirteen: Click on the 

Add a Layer Style icon (ƒx) 

at the bottom of the Lay-

ers panel and choose Outer 

Glow. Set the Blend Mode 

to Overlay and the Opacity to 

75%. Click the yellow color 

swatch, choose an orange 

color (R:249, G:199, B:65), 

and click OK to close the 

Color Picker. Enter 9% for Spread and 250 px for Size. Click OK 

to apply the layer style. Add some text to complete the effect. ■ 

http://www.adorama.com
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Dirty
Tricks

One of the secret powers of the Mixer Brush is that it can sam-
ple multiple colors or even pixels to use for its stroke. This is 
great for creating color-rich strokes to simulate painting with a 
real brush, but for this project we’re going to use an image as 
the paint source to create repeating segments that can be used 
for anything from robot arms to your very own superworm.

mix it up
B Y  P E T E  C O L L I N S

Step One: Start with an image of a sphere. (You’ll probably 

want to try a lot of different types of images after this, but let’s 

start simple.) If you’re using a stock image, use the Elliptical mar-

quee tool (nested under the Rectangular Marquee tool [M] in the 

Toolbox) to make a selection around the sphere. (Tip: As you’re 

drawing the selection, you can press-and-hold the Spacebar to 

reposition the selection.) Press Command-J (PC: Ctrl-J) to create 

a copy of the sphere on its own layer.

[KelbyOne members may download the file used in this tuto-

rial at http://kelbyone.com/magazine/issue/january-2015. All 

files are for personal use only.]

Step Two: Create a new 12x8" document (File>New) at 300 

ppi, set the Background Contents drop-down menu to Trans-

parent, and click OK. Using the Move tool (V), click-and-drag 

the copied sphere into this new document. You can use a Color 

Overlay layer style or a Hue/Saturation adjustment layer to re-

color your sphere if you need to. You’ll probably need to use Free 

Transform (Command-T [PC: Ctrl-T]) to size the sphere so that it’s 

slightly larger than the widest part of the worm that you want to 

create to give yourself a little wiggle room.

Step Three: Make sure that you have the Mixer Brush tool 

selected. If not, click-and-hold on the Brush tool (B) in the Tool-

box, and choose the Mixer Brush from the flyout menu (or cycle 

through the Brush tools by pressing Shift-B). You’ll notice that 

the Options Bar for the Mixer Brush has a few more items than 

the regular Brush tool. There are several important options that 

have to be set correctly for this to work. The fifth icon from the 

left is the toggle for Load the Brush after Each Stroke, and it 

needs to be clicked on in order to load up the sphere colors. The 

Wet setting needs to be at 0%, the Load and Flow at 100%, and 

Sample All Layers needs to be turned off.
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Step Four: This process is a lot like sampling something for the 

Clone Stamp tool; the only difference is that the Mixer Brush only 

clones what’s inside the diameter of the brush, so you’ll need to 

choose a hard-edged round brush that’s slightly larger than the 

sphere (we used a dotted line here so you can better see the 

circumference of the brush in our example). For a hard-edged 

brush, click on the brush preview thumbnail in the Options Bar 

to open the Brush Preset Picker, and set the Hardness to 100%. 

Use the Bracket Keys on your keyboard to quickly change the 

size of the brush.

Now place your Mixer Brush cursor in the center of the 

sphere and hold down Option (PC: Alt) and click to sample. You 

should see the sphere appear in the small preview thumbnail in 

the Options Bar next to the Load the Brush icon. If you acciden-

tally left Sample All Layers turned on and, say, you’re working 

on a white background, your sample will probably have a white 

border around the sphere that you might not notice until later, 

which can cause problems.

Step Five: Now that you have your brush loaded and ready to 

go, click on the Create a New Layer icon at the bottom of the Lay-

ers panel, and give it a whirl. Depending on what brush you’ve 

chosen and its settings, you can either have a really cool-looking 

Doc Octopus arm-like stroke or a big blob. The first things to 

check if things don’t look right are the Load and Flow settings. 

If they’re not at full strength, it can result in some transparency, 

and if you have the Wet option turned on, it can cause the stroke 

to smear together. The top example here is correct, but the bot-

tom example has Wet set to 100%.

Step Six: One of the most powerful features in Photoshop is the 

Brush engine, and we’re going to open it to tweak the look of 

the stroke. The good news is that we’re only adjusting a couple 

of settings. Click on the third icon from the left in the Options 

Bar and the Brush panel pops open. Make sure Brush Tip Shape 

is selected at the top of the list on the left side of the panel. You 

only have to adjust one slider here, Spacing. Moving it to the left 

paints the spheres closer together; moving it to the right paints 

the spheres further apart. With the panel open, you can make 

practice strokes in your document and see the results. Tweak 

until you’re happy.

Step Seven: If you have a pressure-sensitive input device such 

as a Wacom Intuos tablet, then you can go to the Shape Dynam-

ics section in the Brush panel and choose Pen Pressure from the 

Control drop-down menu under Size Jitter. Also, make sure that 

Pen Pressure is turned off in the Transfer section, as you don’t 

want the pen pressure affecting the transparency. This will allow 

you to make parts of your worm smaller or larger by simply apply-

ing more pressure. An even faster way is to simply toggle on the 

last icon in the Mixer Brush Options Bar to get the same result.
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Step Eight: If you don’t have a pressure-sensitive device, you 

can still get the look you want by combining a couple of tech-

niques. Draw out a straight worm that’s as fat as the fattest part 

on a new layer. Use Edit>Puppet Warp to reshape the worm, try-

ing your best to keep it as smooth and natural as possible. Simply 

click in several places along the length of the worm to add pins 

and then drag individual pins to see how it affects the shape. If 

you mess up on a section, you can always click on that pin, delete 

it, and start again.

Once you get it pretty close, press Enter to commit the Puppet 

Warp, and then use Filter>Liquify to help smooth it out and taper 

it a bit. Remember, use the Forward Warp tool (W) in Liquify to 

make small adjustments and just bump the edges over and over 

until you get the shape you want—baby steps.

Step Nine: Double-check that Sample All Layers is turned off—

this will get you almost every time as seen in the example below.

Also pay attention to the direction of the light on the spheres: it 

will look a lot different when you paint in different directions. If 

you’re creating multiple tentacles, create each one on its own 

layer to make adjustments and masking easier.

If you can use a pressure-sensitive tablet, envision drawing in 

three dimensions and it will help you regulate the pressure bet-

ter. In other words, if you think about one end of the worm being 

smaller because it’s farther back in the image and the other end 

being bigger because it’s getting closer as it moves across the 

page, it will help influence your hand. Weird, but it works. 

Step Ten: That’s all there is to it. Because this technique is so 

easy and cool, once you get the hang of it, the hardest part will 

be to come up with new ways to use tentacles in your imagery. 

Perhaps you could specialize in robotics rendering or ductwork 

diagraming, or maybe you will land a gig luring folks to try out 

fishing. But that’s just a drop in the ocean. Don’t stop at just 

making tentacles; see what other images you can sample to 

come up with your own superfunky Mixer Brush strokes.

Understanding how a tool works empowers the craftsman to cre-

ate more things faster and better. Creating something fun like 

superworms is a great way to better understand the Mixer Brush 

and opens the door to creating “reel” pretty pictures. ■ 

D O W N  A N D  D I R T Y  T R I C K S  › ›

http://www.reallyrightstuff.com
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DesignMakeover
C O L U M N  ›  ›

JAKE WIDMAN

“We’re really professional. 
There’s nothing ‘alternative’ 

about our office in downtown 
San Francisco.”

Dr. Lonna Denny first opened her chiropractic practice in 2002 under 

the name Optimum Health Chiropractic. In 2011, she reorganized as 

a corporation—Denny Chiropractic Corp.—and changed the name 

of the business to the San Francisco Spine Pain Relief Center. At that 

time, they also did a visual refresh of the brand to go with the new 

name, including their current logo. 

Besides appearing on their business cards and other collateral, 

the logo is the centerpiece of their office’s row of second-floor win-

dows overlooking San Francisco’s Geary Street. The three windows 

to one side of the logo offer the Center’s Web address and an invi-

tation to live pain-free, while the four windows on the other side 

provide the phone number and a declaration that they’re the city’s 

best chiropractor. 

When asked what sets her practice apart, Dr. Denny says, “One 

of the main differences is that we have a cold laser, so we treat 

extremities and sports injuries.” They handle a lot of personal injury 

cases for attorneys, she points out. She also tries to differentiate her 

practice from the general category of natural or alternative medi-

cine. “We’re really professional,” she says. “There’s nothing ‘alter-

native’ about our office in downtown San Francisco.”

Besides that professionalism, she also wants passersby looking at 

her windows to get the impression of an operation that’s clean-cut, 

thorough, and luxurious. While Dr. Denny is happy with her current 

logo and isn’t seeking a rebranding, she agreed to let us give three 

designers a crack at her window presentation—including her logo, 

if the designers wished.

window treatment
My idea for the window redesign for the San Francisco Spine Pain 

Relief Center was to be straight, to the point, and clean-cut. I kept 

the original colors of orange and black. This being a doctor’s office, 

I wanted to integrate an image from the human body of the doc-

tor’s specialty without being graphic, while still keeping the branding 

modern, as well as professional. 

The signs needed an image that communicates that this is a medi-

cal office. The new signs feature the silhouette of the spine, colored 

black against the orange background. Each of the individual signs 

displays a different section of the spine. The order of the sections 

run from top to bottom, with the top section on the far left and the 

bottom section at the far right. I did this both because I didn’t want 

to repeat the same image and because I wanted to establish a flow 

from the left to the right. The windows now also tell a story, showing 

each piece of the spine. For the signs on the right, I kept the phone 

number because it makes it easy for patients to contact the doctor 

for an appointment.

In addition to the series of smaller signs, I reworked the logo to 

match the branding and also incorporate the spine silhouette. The 

new logo retains the shape of the medical cross while using the sil-

houette of the spine as the vertical line. The squares on both sides 

and the words “Spine Pain” form the horizontal line of the cross.

I chose Myriad Pro for the font because I feel it’s easy to read and 

professional. Rounding the edges of the signs gives them a modern 

feel and also reflects the fact that the spine has a curve to it.

APPLICATIONS USED: Adobe Illustrator CS6 and Adobe InDesign CS6

CAROLINE MAIN
Caroline Main is an artist, graphic designer, and crafter who has always had a passion for creativity. Since childhood, she always enjoyed draw-
ing and painting pictures of her family, nature, and abstract designs. Her childhood interest in art grew to include Web and graphic design in 
high school. She has also toyed with the idea of becoming an art teacher, getting a bachelor’s degree in art with a minor in education from 
the University of Virginia’s College at Wise, supplemented by additional night classes in graphic and Web design. 

Caroline continues to gain experience creating designs for events, nonprofits, small businesses, and others. Her design work includes creating 
logos, print design, and more. Her inspiration continues to stem from nature, and her favorite design work is logo design. Caroline currently 
resides in Salt Lake City, Utah, with her husband, where she works as a full-time graphic designer and does freelance, as well. 

about the designer

CLIENT
San Francisco Spine Pain Relief Center 
www.sfchiro.org

makeover submissions
WE’RE LOOKING FOR PRODUCT PACKAGING OR LABELS, PRINT ADVERTISEMENTS, WEBSITES, AND MAGAZINE COVERS THAT ARE CURRENTLY IN THE MAR-
KETPLACE FOR FUTURE “DESIGN MAKEOVERS.” SO IF YOU OR SOMEONE YOU KNOW HAS A DESIGN THAT YOU’D LIKE US TO CONSIDER MAKING OVER, OR 
IF YOU’RE A DESIGNER AND YOU’D LIKE TO BE CONSIDERED FOR A FUTURE “DESIGN MAKEOVER,” SEND US AN EMAIL AT LETTERS@PHOTOSHOPUSER.COM. 
(NOTE: THIS IS PURELY A DESIGN EXERCISE AND THE DESIGNERS DO NOT WORK DIRECTLY WITH THE CLIENT, CREATE FUNCTIONING WEBSITES, ETC.)

 ›  ›  D E S I G N  M A K E O V E R

DESIGNER
Caroline Main 
www.cnmdesignstudios.com

afterbefore

kelbyone.com
www.sfchiro.org
mailto:LETTERS@PHOTOSHOPUSER.COM
www.cnmdesignstudios.com
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The San Francisco Spine Pain Relief Center owner likes her existing 

logo, which has only recently been redone, so I used that as the basis 

for redesigning the window signage. I wanted to keep a very clean 

look and feel, but at the same time create something that would 

stand out on this building among all the other business signs.

Being that they are located on the second floor, I thought that 

using circles along with the client’s logo colors of orange, black, 

and white would work nicely to give the windows a bold and clean 

design that could stand out and be easily readable from street level. 

Since it’s a chiropractor’s office, I decided to use a wave of circles in 

the design to emulate the shape of the spine. The wave flows nicely 

from the first window to the last.

The current windows use an orange background all the way 

across, which to me makes them look a bit outdated. My redesign 

can work two ways: in one variation, the top of the window has a 

black background, which helps the text and other elements to stand 

out more. If the client doesn’t want such a dark background on the 

windows, the design works just as well with just the colored circles. 

This approach would allow for an up-to-date, fun, easily readable 

design while still letting plenty of natural light into the offices. 

I chose two fonts for the redesign. The sans-serif Avenir Lt Std 

Black is a popular standard font that’s very easy to read, and works 

well on this large-scale design. I also put some of the text in Trump 

Mediaeval Lt Standard Bold, which appears to be the same font that 

was used in the client’s logo. It ties the logo in with the rest of the 

design and also makes some of the text stand out more. 

TAFFY CLIFFORD
Taffy has 20 years of experience as a graphic designer. She was working in the construction industry full-time in Boston as a subcontracts 
coordinator and field engineer, when she realized that her part-time job as a graphic designer was what she really wanted to do. Since then, 
she’s gained experience in marketing and promotional materials, logos, and website design for various clients. She’s worked as a senior graphic 
designer for Staples Corp. in Framingham, Massachusetts, and for Impact Advertising and Florida Suncoast Tourism Promotions in Florida.

She currently works at Kelby Media Group (Photoshop User’s publisher), where she’s been the senior associate designer for a little more 
than 10 years now. She primarily works as the graphic designer for Photoshop User’s feature articles. She also worked as a designer on Mac 
Design, Layers, Adobe Photoshop Elements Techniques, and Adobe Illustrator Techniques magazines. Originally from Massachusetts, she 
moved to Florida 18 years ago and now lives in Dunedin.

APPLICATIONS USED: Adobe Photoshop CC 2014 and Adobe Illustrator CC 2014

I found this to be a bit of a difficult redesign project due to the mul-

tiple windows that are spaced out and have a window frame run-

ning through the center. I felt that having a solid image that would 

run the length and height of each window would be too busy, 

would become distorted if the windows were partially opened (as 

some of them are in the practice’s Facebook cover photo), and 

might make the windows difficult to use. After looking through 

their website and social media pages and looking closer at their 

business location, I decided to design a set of graphics that would 

cover the windows, but would be broken up in color for the top 

and bottom of each window.

I pulled the orange color from their logo and chose a darker blue 

secondary color for a lightly pinstriped background, which would 

help make the orange stand out while giving it a professional look.  

I also included a slight curved line running across the windows, 

which is a subtle reference to the correct curvature of the spine. 

I pulled the fonts from their existing logo to maintain a consistent 

look across the entire graphic. The current windows don’t display a 

list of services offered, so I incorporated the list from their website. 

That way, potential customers can immediately see what they offer, 

which will hopefully drive traffic into their office or at least let people 

easily read the contact information for use at a later time.

My decision to cover each window completely was to allow more 

of an impact from the street and to minimize the amount of office 

shown inside, which distracts from their current signage. I would 

suggest printing the design on perforated window decals, which 

would allow privacy from the outside while letting light into the 

office and allowing clients and staff to still see out.

APPLICATIONS USED: Adob Photoshop CC and Adobe Illustrator CC

DAVID ELLSWORTH
David Ellsworth is a graphic designer based out of Pembroke, Massachusetts. He currently works full-time for an engineering firm based in 
Albany, New York, in their in-house design group. He is also a freelance artist with numerous clients around the New England area, including 
restaurants, attractions, authors, local films, and more.

David is a big believer in networking and maintaining a solid client relationship. He has won several design contests throughout the years; 

most recently he was awarded first place in the yearly design contest at PhotoshopCafe.com and has had worked published in Popular  
Photography magazine. This is his second entry in the Photoshop User “Design Makeover.” 

David also enjoys special effects make-up and acting work for Barrett’s Haunted Mansion in Abington, Massachusetts. He would like to 
thank his wife Amy, daughter Becca (5), and son Logan (2) for their continued support and source of inspiration. n 

about the designerabout the designer

DESIGNER
Taffy Clifford 
http://members.photoshopuser.com/TaffCliff/portfolio

after

D E S I G N  M A K E O V E R  ›  ›  ›  ›  D E S I G N  M A K E O V E R

DESIGNER
David Ellsworth 
www.DavidEllsworthDesign.com

PhotoshopCafe.com
http://members.photoshopuser.com/TaffCliff/portfolio
www.DavidEllsworthDesign.com
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LESA SNIDER
Beginners' Workshop
 getting started with liquify

Step One: Happily, the Liquify filter in Photoshop CC works 

with smart filters, meaning you can use it nondestructively. If 

your document consists of one layer, choose Filter>Convert for 

Smart Filters. If you have multiple layers, activate them by holding 

Shift or Command (PC: Ctrl) and clicking on them. Then choose 

Filter>Convert for Smart Filters. Click OK in the resulting dialog 

and Photoshop sandwiches your layers into one. In CS6 or earlier, 

create a stamped copy of visible layers by pressing Shift-Option-

Command-E (PC: Shift-Alt-Ctrl-E), and then drag the resulting 

layer to the top of your layer stack.

Tip: To reopen your original layers, double-click the thumb-

nail of the sandwiched layer (the smart object) and they open in 

a temporary document. Make your changes, choose File>Save 

(not Save As), close the temporary document, and your changes 

appear in the original document.

[KelbyOne members may download the files used in this tuto-

rial at http://kelbyone.com/magazine/issue/january-2015. All 

files are for personal use only.]

Step Two: Choose Filter>Liquify and turn on Advanced Mode. 

In this example, the Clone Stamp tool was already used (on an 

empty layer) to remove the jowl shadow, leaving us with the task 

of scooting the jaw pixels inward. First, freeze areas near the jaw 

so they don’t move; press F to grab the Freeze Mask tool and 

drag across her shoulder and neck wrinkle (don’t freeze the hair 

strand as it needs to move with the jaw). With the Show Mask 

checkbox turned on, a red overlay appears as you drag. If you 

freeze too much, press D to grab the Thaw Mask tool and paint 

across that area.

Step Three: Press W to grab the Forward Warp tool. It pushes 

pixels forward, ahead of your cursor in the direction you drag. It’s 

great for bulge-busting, waist-nipping, arm-slimming, and tug-

ging mouth corners upward into a smile. Mouse over to the right 

side of her jaw and with a brush roughly the size of the area you 

want to affect, drag to move pixels right and slightly upward. 

Reduce the brush size as you near the chin. Tip: Decrease the 

brush size with the Left Bracket key ([) and increase it with the 

Right Bracket key (]). To undo brushstrokes one at a time, press 

Command-Option-Z (PC: Ctrl-Alt-Z) repeatedly. 

When fabric wrinkles, jowls strike, tummies pooch, or eyes squint, the Liquify filter is your best friend. In this 
column, you’ll learn how to use it nondestructively for some heavy-duty yet realistic retouching. Not all portraits 
need this level of fluffing, but if your client requests it, here’s how to get it done.

If you produce a rippled edge, press E to activate the Smooth 

tool (new in CC 2014) and brush over that area to soften the 

edit’s strength. Keep brushing and you’ll eventually remove the 

edit, or you can press R to grab the Reconstruct tool and remove 

the edit in one stroke.

Step Four: Repeat for the left side of her jaw, and click OK 

when finished. To reopen the filter for more editing, double-click 

the word “Liquify” in the Layers panel. Here’s the final result.

Now, let’s perform some tummy tucking and waist slimming on 

another image.

Step One: Follow Steps One and Two above to prepare your 

document for smart filters, open Liquify, and freeze areas near 

the ones you’ll change. Press W to grab the Forward Warp tool 

and push the pixels inward toward her waist (while the Push Left 

tool is great for slimming, it will distort the bricks more than the 

Forward Warp tool will). Adjust brush size according to the area 

you want to affect; for example, use a bigger brush to slim the 

waist and a smaller one to push in fabric folds (shown here).

Step Two: Press S to grab the Pucker tool, which is great for 

shrinking areas. Make your brush nearly as big as the tummy (to 

avoid changing areas that you don’t want to), and click repeat-

edly to collapse pixels in on themselves. The pucker effect is con-

centrated in the cursor’s center, so make a few clicks on the tum-

my’s left and a few on the right to make the pucker even. Click 

OK when finished. If necessary, reopen Liquify and continue edit-

ing, or use the Smooth or Reconstruct tools as described earlier. 

Tip: Pressing Option (PC: Alt) makes the Pucker tool act like the 

Bloat tool, which is great for enlarging squinty eyes, lips, etc.

Step Three: To fix the brick smearing due to the slimming, press 

Shift-Command-N (PC: Shift-Ctrl-N) to create a new layer, name 

it “clone stamp – bricks,” and click OK. Press S to grab the Clone 

Stamp tool. In the Options Bar, set the Sample menu to All Layers.

Step Four: Option-click (PC: Alt-click) the area you want Photo-

shop to copy pixels from (the sample point, note the crosshair cir-

cled here), release your mouse button, move to the area you want 

to fix and then drag to start copying pixels. You’ll need to change 

your sample point often to re-create brick texture and mortar. 

Here’s the final result. As you can see, editing with the Liquify 

filter takes time but it’s extremely powerful. By using smart filters, 

your original image remains unharmed, plus you can fine-tune 

your edits later. Until next time, may the creative force be with 

you all. ■ 

Before After

Step One

Step Three

Step Two Step Four

Step One Step Two

http://kelbyone.com/magazine/issue/january-2015
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Developing
a Business Plan By Tamara Lackey
I often hear people say that they’re creative, but they’re not 
that good at business, or that they’re business-minded but 
not really the artsy type. Although people may lean more in 
one direction than in the other, the idea that you have to be 
either-or is simply not true. Assuming you’re a creative want-
ing to get a better handle on your business, consider this: 
One of the simplest ways to tackle the concept of building a 
roadmap for your business is to write a good, old-fashioned 
business plan. Just consider doing so in a more modern way. 

Why should you create a busi-
ness plan, especially if you’re  
not planning to seek out funding or 
to ever sell your business? Here 
are several reasons:

1. �Having all your ideas, metrics, strengths, weak-

nesses, projections, and risks (and so much 

more) documented in one place is perhaps 

one of the most helpful things you can do for 

yourself if you’re running a small business. 

2. � Creative individuals are often easily swayed by 

emotions or the next best thing. Having a busi-

ness plan allows you to look at your business 

in a more cool-headed manner and objectively 

see what you had planned all along. The sim-

ple decision to keep a single-minded focus, 

and to not keep changing gears, is a rare and 

rewarding one.

3. �The very act of writing a business plan forces 

you to stop and think about all the aspects 

of what you’re building, helping to determine 

what to include and what to exclude.

4. �The effort of projecting year-end goals 

enables you to determine how feasible your 

business model really is. It’s quite possible 

to have a great-looking business that loses 

money year after year after year because the 

business owner doesn’t pull back and look at 

the numbers.

5. �It offers you the best opportunity to create 

authentic branding that really fits you, your work, 

and your efforts to reach your target market.

6. �It enables you to build a marketing plan that 

takes into account your brand identity, as 

well as a realistic projection of your budget 

and timelines.

When creating a business plan, you don’t want a static 

document that doesn’t account for the almost assured 

fact that things will change often—and rather reliably 

so. A business plan isn’t meant to be tucked away and 

referenced as if it were written in stone. It’s not meant to 

be something you write and then lock yourself into long 

term. Instead, if you create your plan with the intention 

of it being a living document that you revisit often, you’ll 

enable yourself maximum control over your business 

now and in the future.

?
Create

Business Plan
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There’s one additional perk of a creative individual 

taking the time and effort to create a business plan: 

Truly understanding the critical aspects of business pro-

vides a more secure base from which to be truly cre-

ative. If your business is all over the place, and you’re 

just reacting to what the day brings you, how much 

energy do you really have left to be truly creative? By 

better understanding—and then practicing—sound 

business structure, a base to build or keep building 

your business from, you actually generate a significant 

amount of additional time and energy, which translates 

rather naturally into free, creative energy. It may seem 

counterintuitive to suggest more structure to get more 

creative energy but, in my experience—and in the expe-

rience of a number of successful creatives—it bears out 

as true time and time again.

By writing a business plan, you get to answer some 

pretty important questions: 

1. �What do you want your business to be  
known for? 

2. How are you going to sell that? 
3. �How are you going to run your business to 

provide for that? 
4. �How are you going to make a profit you’ll be 

happy with, the money you take home after  
the expenses of doing business?

Once you’ve decided it makes sense to have a plan, here 

comes the next biggest hurdle: actually getting started.

1. You don’t know where to start.
2. It all seems so big, so much.
3.� �You’re afraid you won’t do it right, or you  

will fail.
4. �You already feel too overworked or drained, 

and this is just one more thing to do.
5. �You’re too perpetually distracted to get  

through it, much less to start it.
6. It just isn’t something you want to do.
 7. You can’t find the time.
8. You don’t think you know all the answers yet.
9. �You don’t want to start until you know it will  

be perfect.

What’s the one suggestion I can offer that addresses all these 

resistance points? The best solution to counter putting something 

off because it seems too big, or too much effort, or too confusing 

(or whichever one you relate to most), is to simply break it down 

into smaller pieces, and then start on one of the smaller pieces. 

Yes, just start. And feel free to start anywhere. But start.

When I wrote The Posing Playbook, I felt every one of those 

resistance points. So my solution was to start in the middle. For 

some reason, I wanted to write the section that I knew would 

be in the middle. Instead of starting with an introduction, then 

wading through technical information that I wanted to share 

(but not then and there, exactly), I began with a more enjoy-

able part of the book. As I wrote, other ideas sparked, and  

I saved those for other parts of the Playbook. 

The same approach works quite well for a business plan. 

Even though, chronologically, it starts with your Executive Sum-

mary, most experts would agree that you write that section last, 

when you have a better overall picture of what the summary 

will be because you’ve written the actual plan.

Research shows that most people highly overestimate the 

unpleasantness of the task on which they’re procrastinating. 

One effective trick to overcoming this is allotting a short amount 

of time to just getting started. Set an alarm for a short, speci-

fied amount of time, say 15 minutes, and tackle a project for at 

least that amount of time. It’s hard to argue with a 15-minute 

stab at a task I’m resisting. Sure enough, as soon as I get about 

15 minutes in, I find the task easier than assumed, and I keep 

going—nearly always. But if I told myself I was going to block 

out the whole day to make it happen, I probably would have 

put that day off again and again.

Business 
Planning

Managing 
AND PROCRASTINATION

When It  Comes to
RESISTANCE

Overcoming your own resistance 
to creating a plan can be a huge 
factor. What are some reasons 
you might procrastinate?

Research shows that most  
 people highly overestimate the 

unpleasantness of the task on which 
they’re procrastinating.
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BRANDING

Strategizing 
Identity and YOUR

Another excellent reason to write a business plan is so you can take 

the time you need to figure out what you want to communicate 

about who you are, what your business does, and how people should 

perceive you. By better understanding the brand identity of your busi-

ness, the better you’ll be able to shape your clients’ perception of it.

What is a brand identity? It’s the words, colors, designs—all 

the elements of a brand—that helps clients distinguish your 

brand from other brands. Have you ever felt like you’re lost in 

a sea of competing businesses? Chances are, you may not have 

put a significant amount of effort into identifying your individual 

brand, and why and how it should stand out in your market.

When you’re running a small business, much of your brand 

identity is tied up in who you are, which isn’t always something 

that people know, or certainly aren’t able to explain in a succinct, 

short description. When asked, “Who are you?” as it relates to 

communicating that through a brand identity, the answer isn’t 

about your profession (“I’m a photographer,” or “I’m a graphic 

designer”), or about the roles you play (“I’m a father,” or “I’m a 

wife”), or your address (“I’m a Texan”). When stripped of profes-

Building out a marketing plan is one of the most effective aspects of 

creating your business plan. In this day and age, every marketing plan 

should contain a dedicated focus to a business’s online presence. It may 

seem incredibly obvious to state that your business should have a web-

site, but there are many small business owners who still resist building 

a website, or perhaps build a bare bones site that doesn’t consider the 

first impression a client may have when viewing the website. In today’s 

competitive climate, it’s simply no longer enough to say, “I gain referrals 

by word of mouth, so I don’t need a website.” 

Consider this scenario: You’re waiting in line to buy tickets at a 

movie theater, and the couple in front of you is raving about this 

amazing photographer and the incredible work he does. They say 

his name very clearly and distinctly, and your interest is piqued. 

Do you:

A. �Write down the name, and then go home and look him 

up in the yellow pages?

B. �Discover the photographer’s studio address and drive 

by his studio to look at his work?

C. Google him and check out his website? 

Of course, for the vast majority of potential clients, the answer is C. 

Building a clientele off of word of mouth is excellent, no doubt, but 

you must consider the next step that’s taken after they hear about 

you. The next step is heading to your website to determine if they 

agree with the assessment they heard, or overheard.

How is your website designed? Is it built to showcase your 

work or to generate revenue? Is it designed to encourage book-

ings? Our studio’s website has come a long way since its first 

incarnation in 2003. It used to be a site where you could see a 

whole lot of small images on a black background, with the oppor-

Smarter 
MARKETING

Creating
PRESENCE

AN ONLINE

Tied into
sion, roles, geography, and associations, who are you when these 

things change? What are your skills, abilities, interests, talents, lim-

its, or experiences? What is the succinct way you can define this 

composite of who you are? 

Here are some questions you can ask yourself to start thinking 

about your brand identity in more detail: 

1. �What are you really, really, really good at—just quite natu-

rally talented at? You may be greatly skilled at putting peo-

ple at ease, or perhaps you love technology and pick it up 

quickly and effortlessly. Maybe you’ve always been drawn 

to tackling challenging situations. These strengths should 

be highlighted in your overall business identity.

2. �What promises do you know you’ll keep? Perhaps integrity 

is an inherent personality trait, just like integrity in service 

will be a strong marker of your brand identity.

3. �What are your personal aesthetics? Do you like bright and 

clean, or are you drawn to dark and moody?

4. �Are you a more casual or a more formal individual by 

nature? Are you drawn to traditional and elegant brands, 

or are you more interested in fresh and modern?

This effort to determine your authentic brand identity can play directly 

into how you set up your business to handle volume. If you find that 

you’re slower, more thoughtful, and engaging, you may want to set 

up a business that does low volume and provides tailored services to a 

smaller client base. If you absolutely thrive in quick-moving environments 

and you find that you work best in fast bursts of energy, rapidly fired 

throughout the day, you may want to create a business that’s based on 

a high volume of clients and repeated high-energy interactions. 

There’s an endless number of questions you can ask yourself 

here, but the goal is to create a short, succinct statement about 

your company’s brand identity that you can showcase in all your 

visual communications and feed into your marketing efforts. This is 

a significant first step, determining your brand identity; if you dive 

right into marketing without doing this, how cohesive are the mes-

sages that you’re communicating? If you don’t know, it’s proba-

bly because you don’t have a distinct brand identity that you have 

thought through and included in your business plan. 

The brand identity that you uniquely create for and around 

yourself is quite possibly the biggest advantage you have in a sat-

urated market.

“When you’re  
running a small busi-

ness, much of your 
brand identity is tied 
up in who you are...”  
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tunity to seek out an email address to contact the studio. Now 

tamaralackey.com is built with a clean and simple interface, even 

though it houses a great deal of content. There are large images 

and clear navigation, and every page and post is built for maxi-

mum SEO (search engine optimization). When nearly everyone is 

using the Internet to research a product or service, you want to 

be sure that your site will be in that search mix, and adhering to 

smart SEO is a big part of that.

Many small business owners address their SEO needs differ-

ently. There are a variety of options available to you. There is, of 

course, the do-it-yourself approach, and there are some very 

strong plug-ins on the market that will guide you through boost-

ing your SEO on each page and post on your website and blog. 

The other option is to outsource the effort for a set maximum 

rate, where you determine how much you want to spend in total 

and let a service take care of it. Another option is to hire an SEO 

marketing company to manage your ongoing efforts for an initial 

fee and then a continuing monthly cost.

Most experts would agree that creating great content reg-

ularly—content that people want to share—is one of the most 

ideal ways to boost your SEO. What is great content? Well, as 

the old adage goes, you know it when you see it. But remember 

this very important factor: If the majority of the content you share 

is imagery, you need to know that search engines don’t really 

recognize imagery, per se. What they do understand is the spe-

cific words that you use to identify the imagery you post to your 

website and blog: the title, any caption you use, those infamous 

alt-tags, and descriptions of the images. 

Have you ever searched the Internet for one thing and found 

images of something else time and time again? Say, for instance, 

you searched for images of the tooth fairy, but you kept getting 

photographs of dentist offices. Chances are that someone some-

where included the phrase “tooth fairy” when describing their 

images or business practice. Search engines don’t quite know 

what to do with images, but they are very good at knowing what 

to do with the descriptors surrounding them.

Finally, I suggest that your site is built with responsive Web 

design, which is an approach to create sites with optimal viewing 

experience on a variety of screens and mobile devices. This is a 

rather important factor nowadays, as the vast majority of Web 

users, estimated at more than 70%, are accessing sites via mobile 

devices first. Whether your website is being viewed on a 15" lap-

top, a 6" phone, or a 12" tablet, you want your client’s initial, and 

subsequent impressions to be consistently strong.

Do you remember that brand identity you built to shape your 

clients’ perception of your business through cohesive messaging 

and visual communications? Ensure that your online presence is 

designed around that look, feel, and messaging so that the words 

you use, the fonts and colors you choose, and the style of your 

overall design all coordinate. 

It will undoubtedly take a lot of time and effort to build your business 

plan, brand identity, and online presence as it relates to marketing, 

but there are few things that are worthier of your time and effort if 

you’re intent on building a business for the long haul. Best of luck! ■
ALL IMAGES BY TAMARA LACKEY

“The brand identity that 
you uniquely create for 
and around yourself is 

quite possibly the biggest 
advantage you have in a 

saturated market.”

“Most experts would agree  
that creating great content  

regularly—content that people  
want to share—is one of the most 

ideal ways to boost your SEO.”

http://kelbyonelive.com


› 
› 

k
e

l
b

y
o

n
e

.c
o

m

061

A s photographers or visual creatives, social media gives 

us an unprecedented platform to share our work; to 

engage with fans, as well as potential clients; and 

to grow our brands. In this article, let’s look at a couple of the 

largest and most influential avenues out there and discuss how 

best to use them, how to prep your work for sharing, and how 

to unify your message across platforms so those hours spent on 

the Internet pay off. IMAGES COURTESY OF THEIR RESPECTIVE OWNERS

‹‹ My skills include donut eating ››

by
C O L U M N  › ›

SOCIAL MEDIA: JOIN THE CONVERSATION

Erik Valind

Do you find yourself like the rest of us, losing hours every week, sucked into the void of your Facebook news feed? 

Does the sheer number of different social media platforms popping up every day overwhelm you? There is hope! 

› › B Y  D E S I G N

WHERE TO INVEST YOUR TIME
So we’re not overwhelmed with all the options or latest buzz-

worthy social media platforms, let’s start with the big dogs 

in this arena: Facebook, Twitter, Instagram, and LinkedIn. All 

of these websites have monthly active user counts (MAUs) 

in the hundreds of millions, and Facebook alone has more 

than one billion users on its website every month. Quite the 

potential audience, huh? Each one of these sites varies a lit-

tle in the types of users they attract and how they’re used for 

communication. Here’s a quick breakdown:

Facebook: The social network website that everyone’s on. The 

goal is to initiate conversation by easily sharing things that you 

like, be they status updates, website links, photos, or video.

Twitter: Microblogging site that caps your post at 140 char-

acters and embedded photos. This is a great platform to 

share brief status updates or links to more in-depth posts on 

your Facebook, blog, or website.

LinkedIn: Business-oriented social media website. A digital 

CV/résumé with a social element. Less of a diary of what you 

ate for lunch and more of a place to share business contacts, 

referrals, and your qualifications.

Instagram: Smartphone app based on sharing photos and 

short video clips. One of the first and largest photo apps to 

embrace social interaction and build a community beyond 

just pretty pictures. It’s now owned by Facebook and has a 

website version, as well.

WHERE TO BEGIN? YOUR PROFILE!
You’re the cornerstone of all of these networks, so you’ll 

have to set up a profile so people know with whom 

they’re getting social. You’ll need at least three things to 

get started: name, photo, and bio. Start by using your real 

name. If you’re a photographer or artist, you want people 

to find you and your work; that’s why you’re creating a 

social media presence and sharing in the first place, right?

Next, your profile photo, or avatar, should be a cur-

rent photo of you. You want people to recognize you and 

eventually your message and imagery. Try to avoid those 

cropped-in party snapshots from five years ago, or random 

graphics. Social media has opened up a whole new reason 

for everyone to get a professional headshot.

‹‹ I’m eating a donut ››

‹‹ I like donuts ››

‹‹ Here’s a vintage photo of my donut  ››

‹‹ Here’s a pretty donut recipe ››

‹‹ This where I eat donuts ››

‹‹ Here’s a video of me eating a donut ››

‘‘ ‘‘

You’ll need at least 
three things to get 
started: name, photo, 
and bio.

SOCIAL MEDIA EXPLAINED
This clear and concise way of explaining different social media 

sites started as a groundhog on a whiteboard at Three Ships, a 

digital marketing company. Needing to replace the groundhog 

since Groundhog Day was over, they decided to explain social 

media using donuts. Their creative director, Nuono Gomes, 

wrote out the text, and then their multimedia procuder, Doug 

Ray, posted it on Instagram. The analogy quickly took on a life of 

its own on the Internet, and soon people were using everything 

from coffee to cats to explain social media.
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Finally, your bio on these websites is like an elevator pitch 

for who you are. Let them see your personality here, but keep 

it short and sweet. State who you are, what you do, and why 

they should follow or interact with you. 

A UNIFIED FRONT: KEEPING YOUR  
BRAND CONSISTENT
Chances are you’ll be using more than one social media website, 

so the key to being successful across multiple platforms is unifor-

mity. The reason for uniformity is twofold: making yourself easily 

recognizable from one site to the other, and making it easier for 

you to share across multiple accounts.

While you want your work to be seen by as many people 

as possible, your audience may only be using one or two social 

media channels. So you want to be easily identifiable if they 

look for you elsewhere. If fans or potential clients have been 

following you on Facebook for a while, then they open a new 

Instagram account and start looking for photo streams to fol-

low, they’ll instantly recognize you if you have the same avatar 

and bio on both sites. It also makes it easier to share and be 

shared across multiple platforms.

PREP YOUR IMAGES FOR SHARING
You should now have a good idea of when and where you’re 

going to share, so let’s get some pretty pictures ready to go with 

all those posts and updates. After all the time that goes into creat-

ing a great photograph you don’t want to have it displayed poorly 

when shared online, or not displayed at all. To avoid these com-

mon mistakes, let’s walk through optimizing your images for the 

Web, focusing on image resolution, size, and color balance. This 

will ensure that your images look great onscreen and load in a 

timely manner. Once you you’ve finished editing your image in 

Photoshop, simply follow these steps to export it properly.

Step One: Choose File>Save for Web.

Step Two: Resize the image to 600–900 px on the longest side.

Step Three: Verify the image is JPEG and around 200 KB or less.

Step Four: Check the box Convert to sRGB.

Step Five: Click Done.

The final JPEG image file is supported on all social media websites, 

will load quickly, and will have the proper color and contrast no 

matter which Web browser people view it on.

B Y  D E S I G N  › › › › B Y  D E S I G N

Some websites will also have you set up a username or han-

dle. Try to pick a unique handle so you can secure the same 

handle across multiple social media sites. On Twitter and Ins-

tagram my name is Erik Valind but my handle is @ErikVPhoto 

on both. Sharing is a main ingredient in social media, so when 

I post a photo to Instagram, I don’t want it to end there. From 

the Instagram app, I can also share that photo directly to Twit-

ter. Because my username is the same on both platforms, the 

photo already has the correct @ErikVPhoto handle tag, and 

when someone retweets my photo, people can easily follow it 

back to my account and follow me. Likewise, if my Twitter fol-

lowers like the pictures I share on Twitter, they can go straight 

to the source by following me on Instagram and engaging 

there, as well. Uniformity across accounts makes you easy to 

find, follow, and share.

A CONSISTENT MESSAGE AND YOUR VOICE
Uniformity extends beyond your username and profile, too. It’s 

paramount that your message be the same across the board, as 

well. Pick a theme or a specialty and stick to it. People want to know 

what to expect when they follow you. If you talk about photo

graphy one day, astronomy the next, and home improvements 

in-between, you’re sending mixed signals. As a photographer,  

I talk about photography, I share my photos online, and I discuss 

the photo industry. That is the theme of my social media. 

Find your theme and stick to it, then let your style and 

personality blossom within that theme. Bonus points for per-

sonality. When people see that you’re a person and not a 

faceless brand, they’ll be more likely to join in the conversa-

tion. Be sure to keep it positive and upbeat. You don’t want 

to be that gloomy guy online. And remember not to get too 

personal; the Internet is forever, and some things are better 

kept to yourself.

GOALS WITH SOCIAL MEDIA
Now that you’re set up and optimized to share and be shared, 

what are you trying to communicate? What are your goals? The 

phrase, “Plan your work and work your plan” rings especially 

true in social media. Without clear intentions, social media  

can quickly become a time sink full of inane ramblings and 

funny cat videos. As photographers or creatives, we ultimately 

want to share our work and grow our audience of fans and 

potential clients.

Every one of us should have a website or blog where we 

showcase our work, so one great goal is to funnel people 

from our social media accounts to this main page. Share 

snippets of a blog post or behind-the-scenes photos of a 

shoot, and tell people that they can find out more on your 

website. The key is giving them an incentive to visit you there.

Social media is also a great opportunity to grow your 

brand, or more specifically to show people who you are 

and what you do well. Showcase your expertise in a given 

field, be helpful when followers are looking for info, or 

just be funny or pleasant. Do something that makes you 

unique, and give people a reason to be your friend or fol-

lower online. 

Many people post a ton of content right out of the gate, 

then get discouraged when they don’t receive a lot of Likes 

or new Followers. No matter what your goal is, social media 

is about being social. When you first start, find other people 

and pages that you like or admire. Take note of what they’re 

posting, how often they’re posting, and then start engaging 

them. Comment on people’s posts and don’t be shy to follow 

a bunch of people on day one. You truly get out what you put 

in. Here’s a 33% rule that I follow to make sure that it’s not 

all me, me, me.

• Promote your work and website 33% of the time

• �Promote other people and initiate conversation  

33% of the time

• �Promote industry-related information and education  

33% of the time

Optimized image specs: 72-ppi resolution, 600–900 pixels on the longest side,  
less than 200 KB file size, and sRGB color space embedded 

Using the same avatar and bio on all your social media  
sites is key for potential customers and fans to instantly  

recognize you and your work.
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BEST PRACTICES
Follow these best practices to make sure your posts are getting as 

much traction as possible.

Instagram: Hashtags are a way of keywording a post or picture. 

They are simply the # symbol followed by a word with no space in 

between. It’s a great way to discover photos and posts about spe-

cific topics and themes. If I post a photo of a sunset to Instagram, 

only my followers will see it. But if I post the photo and type the 

hashtag #sunset in the caption, then anyone searching for #sunset 

can find the photo whether they follow me or not. This is a great 

way to get new followers.

Twitter: The difference between a Mention and a Post:

A. �@KelbyOne is a great educational resource  

for photographers!

B. �.@KelbyOne is a great educational resource  

for photographers!

Tweet A began with a Twitter handle and will only be seen by 

KelbyOne, which doesn’t benefit my followers. To correct this,  

I began Tweet B with a period (any character or letter will work) so 

it will be seen by every one of my followers as I intended. 

Facebook: It’s becoming more and more difficult for your 

content to be seen on a crowded website like Facebook.  

To make sure the Facebook gods place you above the noise, cre-

ate dynamic posts. When you post photos and video, tag other 

people and pages in your post, and use the location tag and 

any hot links and hashtags that are applicable. Tags make names 

clickable and bring people to their profiles. Simply type the @ 

symbol followed by the username of the person you want to tag 

or directly mention.

LinkedIn: Rather than tooting your own horn, let happy clients 

and colleagues do it for you. You can request recommendations 

and have people vouch for your various skill sets. There’s no better 

advertising than a direct referral. 

The social media flavor of the week changes constantly, so make 

sure to explore other online communities, too. You’ll definitely 

want to look into Flickr and 500px, which are specifically photo 

sharing websites but have sprouted huge communities of their 

own. No matter where you go, remember to stay positive, share 

what you love, and engage—after all, social media isn’t social if it’s 

just a one-way street. See you online! ■

B Y  D E S I G N  › › 

ALL IMAGES BY ERIK VALIND
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by  frank salas

 Is setting yourself apart from the com-
petition really about taking the best 
photos, having the lowest prices, or 

using the latest camera gear? 

prospective  
client contact  
and follow-up
This tip has to be my all-time favorite. How often do you hear people say they 

contacted a business either by phone or email and no one got back to them 

until a week later, or not at all? Yep, it happens all the time! This is where you 

can take the upper hand. Every time I receive an inquiry, especially by email,  

I respond within minutes if it’s during our normal business hours and I’m not 

with another client at that moment. Even if it’s after hours, I tend to get back 

to them the same day. I also follow up the next business day with a phone 

call to see if they received my information and if they have any immediate 

questions I can answer for them. Many think of it as bugging or soliciting 

the potential client; however, remember that they’re trying to reach you and 

appreciate your quick and personal response. 

is it really  
about the  
best prices?
Offering clients the lowest rates never guar-

antees they will purchase your goods or 

services. Instead, offer them the best value. 

For wedding photography packages, add 

additional coverage, a couple extra album 

pages, an extra enlargement for the par-

ents, or maybe even offer them thank-you 

cards for their guests. The point is to not 

worry about giving them the best or lowest 

price, but to add value with some type of 

low-cost product. 

set
yourself

apart       from
the

competition

This is always on the minds of most photographic entrepreneurs. Whether you’re a full-time 
or part-time photographer, or seriously considering making a career in photography, you 
think differently when 100% of your income is derived from taking photos. Don’t get me 
wrong, we all love the latest camera gear; however, the real question is how can we set our-
selves apart in this heavily saturated world of photography? Below are some quick tips for 
keeping yourself ahead of your competition. 

kelbyone.com
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create a photographic 
style that stands out
At a certain point, most photographers think creating the best pho-

tos will give them the upper hand over the competition. I’m all about 

educating yourself and learning the fundamentals of photography 

(lighting, posing, and retouching techniques) and new techniques 

to advance yourself to improve your craft, but it’s more important to 

create a style or a body of work that has a signature look. It could be 

images with high color saturation, or maybe a monochrome look. It 

could be your work has a more relaxed style of photography versus 

an elegant and formally posed approach. Whatever you do, keep it 

consistent. We all love our favorite Lightroom presets and Photoshop 

plug-ins, but don’t overdo it. When people click through your portfo-

lio, do they see that you have a consistent style and look, or do they 

see that you’re trying out all of your favorite filters and each image 

has a different touch or effect? If the answer is filters and effects, 

that’s not good. 

Create a series of images that look uniform so when prospec-

tive clients view your body of work they can quickly see your style. 

your website
How does your website look? More pre-

cisely, what message are you sending to 

prospective clients when they browse 

your website? For example, if you’re a 

portrait photographer, are you showing 

only a dozen family portraits and then 

the rest of your portfolio is a mixture of 

travel or street photography? If you’re a 

wedding photographer, the same thing 

applies. What message do consumers 

get when they look at your online port-

folios? Do you come across as an expert 

in your field? 

There are two points here: Display 

fewer images so you’re only showing 

your best work, and focus on the area 

of photography that you want to pho-

tograph. On my website, I concen-

trate on showing wedding photog-

raphy and engagement portraits. Yes,  

I love all of types of photography, but 

I want a prospective client to see me 

as an expert in my field and not a jack-

of-all-trades. By simply applying this 

technique, it has helped me edge out 

other competitors who do it all. 

I see many websites that look the same. How will you stand 

out if your website has the look and style of other photogra-

phers? Be different and look outside the photography world in 

other industries for inspiration. Ask yourself, “How can I make 

my website different than my competitors?”

network in person
This is an area that many of photographers shy away from or 

perhaps they’ve tried it once a year and gave up. Do you ever 

hear people say that others are successful because of who they 

know? Well, I’m here to tell you that without knowing people 

it’s hard to get the word out about how awesome you are. For 

example, as wedding photographers, we’re out networking 

with wedding planners, wedding venues, and other vendors 

that to-be brides and grooms visit. 

The competitive advantage here is 

that you’re unique and there’s a 

good chance that you will stand out 

by introducing yourself to new peo-

ple. Your competitors are doing the 

same thing, so why shouldn’t you be 

there side by side to show what you 

have to offer. 

On that same note, consistency 

is key. Every month, go to some 

type of meeting or mixer. It can be 

an open house for a new reception location, a florist hav-

ing a grand opening, or the local wedding magazine having 

their annual event. Make sure you mingle, shake hands, and 

say hello because your competitors might stay away because 

they feel it’s a waste of time to meet and greet new faces. 

social network online
We just touched on the physical, in-person approach to getting 

noticed, so now let’s discuss the online method that most of us 

prefer to do. Our blogs were one of the main sources of online 

communication, but now we keep up with each other on a daily 

basis on Facebook and Instagram. It might seem like it’s not 

worth the effort you put in, but the question is, are there any 

immediate or long-term returns? 

I add both my clients and the wedding vendors I want to 

work with to my Friends list. I don’t use my social networking 

sources for keeping up with friends. I mainly concentrate on my 

professional relationships, so the posts I make are related to that. 

After every event or photo session, I immediately post an image 

and tag the clients so that everyone on their network can see 

the image. Doing this the same day or the next day is the key, 

especially after a wedding. If you don’t do this, you’ll see all of 

the images the couple’s friends have posted before you, getting 

all the attention, even though their iPad or iPhone photos aren’t 

great. This is certainly nothing new, but how many of you are 

taking the time and doing it? One last tip: Make them a Face-

book Timeline cover. I always email a collage of photos with my 

logo that they can use as their main Facebook Timeline cover. 

kelbyone.com
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sell a product
If you’re among those who only shoot and burn a photo session and 

are wondering why you can’t get top dollar for your time and talent, 

here’s why: Consumers like value, as we mentioned before. Sure, it 

sounds great to just take their photos, and the thought of them mak-

ing their own prints even sounds better. Or does it? 

How much can you charge and is that rate a good enough rea-

son for them to hire you over your competitors? My solution is to 

sell prints, albums, and a product. You must first invest in sample 

albums, enlargements, and any other products you think will get 

people excited to hire you instead of the photographer who only 

wants to offer a $0.15 DVD with his or her images. You’re inspir-

ing them with your beautiful images, and you’re educating them 

on how to display and share those images with family and friends. 

My biggest sellers are albums. The current norm is to create 

hundreds of images during a session, but how are clients able to 

keep and show all of your amazing work when the only option in 

their mind is, “Can you burn them on a DVD for me?”

Finally, look and act professional. We’ve all heard the saying “dress 

for success.” Position yourself like the people you want to attract. 

First impressions are everything. I’m not suggesting you wear a suit, 

but keep in mind they’re comparing you to other photographers and 

you’re the one they will introduce to their families and friends at 

their once-in-a-lifetime event. Be kind and courteous to all and simply 

keep smiling. ■

ALL IMAGES BY FRANK SALAS EXCEPT WHERE NOTED
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Photo 
Interview with Lynn DelMastro
Lynn DelMastro is the studio manager and producer for Joe McNally. We sat down 
with Lynn and asked her a series of questions about possible scenarios a photographer 
might face with a job. Beginning freelance photographers often don’t see past the job 
at details that can affect how they charge clients, how much time is involved in the pro-
cess, or how to cover themselves in the event of a problem. 

anaging

RC: Lynn, thanks so much for taking the time to talk 
with us about some photography scenarios. I think 
this conversation will be useful for up-and-coming 
photographers. Let’s begin with a product photog-
raphy scenario. 

A client has developed a brand-new case for tab-
let computers and they want pictures of the case so 
they can use it on their blog. This product will likely 
be sold in big box stores and online. They want to 
shoot the product in an office with company employ-
ees holding it and using it. They would like to do this 
as a half-day shoot. 

LYNN: The client has intentionally attempted to lower 
the costs involved in doing this shoot by mentioning “half 
day.” While that might seem cost-efficient to them, to 
me it doesn’t necessarily indicate a cost savings. I don’t 
believe in calculating fees based on a half day. One of a 
few exceptions is if you’re a freelance newspaper pho-
tographer and sent out on multiple assignments per day. 
But for all other photographers, to take on even a single 
assignment on any given day means you typically can’t 
take any other job for that day. You could book a half day 

oot :
with Client A, and then Client B calls and needs you for 
a full day. You have to turn Client B down and lose that 
revenue. Also, just because the client says it’s a half-day 
shoot doesn’t mean you only work when you’re shoot-
ing. You have to prep, pack (unless your assistant does 
that, in which case that’s a billable expense item), drive to 
location, set up, shoot, strike the set (even if it’s minimal), 
and drive back to your studio. Not exactly a half day, is it?

Whenever a client asks you what your day rate is, 
I recommend replying, “What type of licensing do 
you want for the photos?” Here’s another example 
of dispensing of the day-rate notion (no matter how 
short the day is) and basing your fee on the requested 
licensing. The license is determined in two ways: the 
term and the usage. The term is the length of time 
the images will be used, and the usage is the media 
in which they will be used. The client in the example 
given here has stated that they only want the photos 
for their blog. Providing they don’t expand on that 
usage, I would categorize this as electronic (blog only) 
marketing and promotion. 

Next up, you need to discuss the term. Many cli-
ents will say that they want the images forever, or 

By Rafael "RC" Concepcion

s  
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Since this client said that there will be company 
employees in the photos, you don’t need to build 
model fees into your expenses; however, make sure 
everyone signs a release. I strongly recommend 
including the services of a hair and makeup stylist, 
as well as a wardrobe consultant, into your produc-
tion expenses. For a shoot like this, the consultant 
will speak with the photo subjects ahead of time to 
ensure that all wardrobe is coordinated. If the client 
won’t spend for any consulting, including hair and 
makeup, then be sure to have a disclaimer in the 
notes of your estimate that say that the photographer 
is not responsible for the grooming of the photo sub-
jects. Great lighting can only go so far to make some-
one look good. Your client will be much happier to 
see everyone looking their best when a professional 
has groomed them. The photo subjects themselves 
will feel more confident and that will come across in 
your images.

All other expenses will be based on your own 
business model. For a shoot like this, I recommend 
charging either mileage or a one-day vehicle rental 
to transport your gear, one or two photo assistants 
(pack and shoot), breakfast and lunch per diems for 
crew, and the grooming services noted above. 

On a whole other note, there’s the digital capture 
line item. There’s capture for the shoot, then there’s 
the postprocessing and editing time you’ll be spend-
ing back at the studio. This all needs to be built into 
the budget. If not, you’ll be chipping away at your 
shoot fee. 

RC: For a corporate shoot, the client would like to do 
a series of images of members of their team, five total. 
These photos will go into use on a website, but the 
company thought that they might use them for other 
purposes down the line. 

They would like headshots of the team, then 
portraits of them working in the office. The client 
states that available light will be fine as it’s usually 
a bright, sunny office, and they think a half day of 
time would be fine.

LYNN: Much of the same information, as I noted with 
the product shoot, applies here. Regarding the client’s 
notion that due to the bright, sunny office, doing the 
shoot with available light will be fine. How nice of them 
to offer that technical advice! With all due respect, 
clearly, you don’t go by that. Also, who’s to say that on 
the day of the shoot it isn’t a cloudy, miserable day? 
Plan accordingly either way. As far as the shoot fee, the 
license they want right now is website. I’d get as much 
fee up front for as much additional usage as possible. 
That will save everyone the trouble of negotiating this 

“in perpetuity.” I always politely question a client who 
requests this because why would they want the 
images forever? Especially technology-based pho-
tos, as the products in the images become dated so 
quickly. I generally recommend a term of three to 
five years. 

It’s important to note that I still hear people use 
the term “buyout.” This makes me crazy because no 
photographer should enter into this arrangement. 
For those of you who aren’t aware, this means trans-
fer of copyright, a.k.a. work made for hire. Why on 
earth would the client need your copyright? (On the 
other hand, happily sell it to them if they’re willing to 
buy it from you for a yacht load of money.) Granted, 
there are exceptions to every rule, but choose your 
exceptions wisely. Once you turn that copyright 
over, you technically can’t use those images in your 
portfolio or for your own promotion. You no longer 
own those images. They are the property of the new 
owners. If you want to use them, you need to ask 
their permission.

Now that you have the term and usage rights 
understood, you can name your fee. Next up are 
the production expenses. For the example given 
here, the client specified that the shoot would take 
place at their office. Whenever possible, I recom-
mend scouting the location ahead of time. This will 
alleviate some of the stress on the day of the primary 
shoot since you can plan your lighting accordingly. If 
you do the scout yourself, be sure to build that time 
into your overall shoot fee. Or, if you send an assis-
tant, build that fee into the production expenses. 

down the road. I’d offer a three-tier package of usage, 
from Web only to annual reports, marketing, and pro-
motion. Make the sliding fee scale very appealing to 
them, where the fee for most extensive licensing 
shows the benefit to buy it now.

RC: Let’s say you’re doing an editorial shoot for a 
magazine that would like to do a feature article and 
portrait of Jane Smith. She’s the founder of a new 
set of toys that promotes research skills for children. 
This is the hot toy of the holiday season and they’re 
looking for an angle to show how a person built a 
business in a garage and is now selling products in 
big box stores. The images are on a deadline, so you 
have three weeks (or some unreasonable amount of 
time that constitutes a rush) to get it done. 

LYNN: Editorial shoots are a great way to show off 
your journalistic ability to tell a story. The amount of 
coverage the editor is asking for will determine if you 
only have to shoot one or two portraits, or a series of 
images that truly captures the essence of the compa-
ny’s growth. Here again, expenses are separate from 
the fee. Expenses would be dependent upon the edi-
tor’s willingness to budget for travel, assistants, meals, 
etc., everything that goes along with doing complete 
coverage (unless the shoot is in your locale). 

Fees with magazines are often a base fee 
against space. If you get a lot of real estate in the 
magazine, they’ll calculate the space of the images 
against the base fee they paid you. Anything above 
that constitutes an additional fee. Word to the wise: 
Be careful with magazines and work for hire agree-
ments. They’re notorious for wanting the copyright 
to your images. Ask them up front if they have a 
photography agreement that you’ll need to sign. 
Review that before you commit to the assignment. 
Sometimes there’s flexibility within the agreement 
to revise some terms, but get it all out in the open 
from the start. ■■ 



P H O T O G R A P H Y  S E C R E T S  › ›

POSTPRODUCTION
This is probably the biggest time commitment in the photography studio today. 
Film shooters had the luxury, and the expense, of having their lab do most of 
the work. Today, that work falls on the photographer. By breaking post into its 
components, it’s possible to see where hiring help might, well, help.
	 At bare minimum, the photographer has to import the photos from memory 
cards, unless it’s a tethered shoot. A fast USB 3 card reader for both CF and 
SD formats will help. The best investment, though, is a really fast comput-
er. A fast, multithreaded machine maxed out with RAM and sporting lots of 
cores will pay for itself in the time saved in importing and editing your images. 
These workhorses can cost up to $10,000, but by getting the photographer 
back to booking, planning, and executing a photographic project for a client, it 
more than pays for itself.

MAKING PHOTOGRAPHS
As much as we’d love to shoot every day, the harsh reality is that we do that 
only about 10% of the time. The other 90% includes propping, getting wardrobe, 
location scouting, packing gear, hiring assistants and make-up artists, and mak-
ing sure that everything is in place to assure a successful photography session. 
	 The six “Ps” that say it all are: Prior Proper Planning Permits Perfect Pho-
tography. The most important P is “Permits.” Planning doesn’t guarantee that 
everything will work out; it merely increases the odds. Remember, whatever can 
go wrong will do so at the worst possible time, causing the most harm. That’s 
Murphy’s Law. Murphy loves photo shoots.
	 We also spend a lot of our time getting the work, in postproduction, archiving, 
making prints or having them made at a lab, and invoicing, not to mention ad-
ministrative tasks such as paying bills, taxes, and balancing the checkbook.

	 After import, the best photos have to be chosen. This is the most difficult 
task for most of us because, frankly, photographers are the worst possible ed-
itors of their own work. We become emotionally involved. Trust me on this, we 
all mark the hardest-to-produce images as selects, even if they’re not worthy 
of making the cut. Our clients will recognize all the hard effort made to produce 
those images, won’t they? (Here comes a harsh dose of reality.) No, they won’t. 
Clients only care that the photographs you make for them tell their stories. 
Period. (Darn it, right?)
	 Consider getting help in making selects. One of the ways to become a better 
editor is by editing someone else’s work. Get with a photographer you respect 
and who respects you. Tell him what your assignment was and have him pick 
his favorites, then ask him to explain why he picked the ones he did. Do the 
same for a project of his. You both will become better at editing you own work.

by Kevin Ames

G oogle defines a studio as “a room where an 
artist, photographer, sculptor, etc., works.” Tra-
ditionally, this has meant a physical location 
usually with a cycloramic wall, prop storage, 

digital-editing suite (or a darkroom back in the days of film), 
reception area, changing room, make-up station, kitchen, 
conference space, administrative office, and gear storage.
	 Today, a studio is anywhere a photographer works, from 
the traditional to a home shooting area, on location, at a cli-
ent’s business, or in the case of portraits, the client’s home. 
Wedding photographers’ studios are often churches or event 

spaces. Absent a physical studio where photographs are 
made, there has to be a place for retouching, archiving, and 
financial administration. It can be a home office or even a 
coffee shop for that matter.
	 No matter what physical form a studio takes, it’s a place of 
business that faces the same challenges as any other busi-
ness. One of the keys to running a better business is efficiency. 
As a photographer, you have many responsibilities that extend 
beyond shooting images, so finding ways to streamline tasks 
and knowing when to hire additional help will make you more 
productive and increase your earning potential.

STUDIO
EFF IC IENCY
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ADMINISTRATION AND EMPLOYEES
Face it, no business runs without paperwork, or at least its 
digital equivalent. The photographer (a.k.a. studio owner) 
must network; show her work; update her website continu-
ously; prepare and revise estimates; book studio time or lo-
cation or both; rent equipment; hire assistants, stylists, and 
talent; make sure model and property releases are signed; 
shoot then bill the job; collect the money; deposit it; pay the 
team and the day-to-day bills; taxes; and so forth. Notice 
that only shooting the job is a nonadministrative task. At 
bare minimum, a part-time bookkeeper is essential. 
	 Employees are expensive. Here’s an absolute truth: If a 
person working for a studio doesn’t generate at least two 
times more income than his or her salary, then he or she 
isn’t worth hiring. Don’t misunderstand me; the staffer 
doesn’t have to personally generate that income. A staff 
member who frees the studio owner’s time to the point 
where more jobs can be accepted and accomplished to pro-
duce that 2x multiplier of his or her wages is truly valuable. 

The modern-day studio finds the photographer wearing all 
of the hats listed above. Good, no, great time-management 
skills are the key to making it all work. Photography is one 
of the last unregulated professions where anyone can open 
a studio for the price of a business license. What sets the 
true professional apart from the rest is the attention to de-
tails of not only the shoot but to the business, as well. A 
synonym for studio might be “business.” ■

P H O T O G R A P H Y  S E C R E T S  › ›

DELIVERABLES AND ARCHIVING
Once the selects have been made and edited, the deliverables are next. They’re what the client re-
ceives. A wedding photographer might create a printed album, the portraitist might make a canvas 
wrap print, and the commercial shooter might deliver high-resolution retouched files for a brochure 
or annual report along with lower-resolution files for the client’s website and email blasts. Will the 
physical prints be shipped, couriered, or delivered in person to the client? Are digital files to be 
sent on CD or DVD, or uploaded to an FTP server? These are questions that must be asked before 
the photography happens so the time for producing the deliverables can be factored into the cost.
	 What happens to the photographs after they’re delivered to the client? Do they get thrown away, 
or are they archived for future sales or use on the photographer’s website and blog? How much 
time does archiving take? What does it cost? Where does the cost factor into the price of the shoot? 
A strong double backed-up archive is a valuable resource for the photographer. Making certain that 
backups are completed nightly could be part of a studio manager’s duties.

Color Correction and Exposure Adjustments
This time-consuming task can be streamlined very easily with a little extra time spent during the 
photo shoot by capturing an X-Rite ColorChecker Passport in one of the images. This pocket- 
sized color reference chart is a one-click color balance tool, as well as a way to get really close 
and consistent exposures. Using it is easy. Either have the subject hold the open Passport 
toward the main light on the subject while you take a photo, or hold it yourself and capture 
an image. This reference image can be used in Lightroom or Camera Raw to quickly set the 
color balance and fine-tune the exposure for all of the images in that light (see Photoshop User,  
December 2014, p. 94 for more on correcting white balance and exposure). A photographer 
who works consistently with a reference like the ColorChecker Passport can have an assistant 
handle the color correction and exposure tweaks without supervision.

Finish vs. Fix
No matter how great everything happens on set, 
be it on location or in a studio, there’s always some 
post required to polish the image. Notice that I said 

“polish,” not “fix.” A photographer that doesn’t get 
images as correct as possible in camera is one 
that’s spending too much of her most valuable and 
limited resource, time, to make up for not bringing 
her best game to the time spent behind the camera. 
Lightroom and Photoshop are finishing tools, not 
fix-it tools. If you catch yourself saying these fatal 
words, “Don’t worry, I’ll fix it in Photoshop,” take 
a step back and see if it wouldn’t be easier to, say, 
remove distracting objects before taking the shot 
rather than having to clone them out later in post.

ALL IMAGES BY KEVIN AMES
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›  ›  l i g h t r o o m  ›  ›

Under 
the 

Loupe
Creating copies of your finished work is probably the main reason 

your photos go into Lightroom in the first place. This issue, you’ll 

learn how to expand the export options in Lightroom to help you 

do more in less time.

extending the power of export
B Y  R O B  S Y L V A N

Output is such a huge part of Lightroom that it has four 
separate modules—Book, Slideshow, Print, and Web—
devoted entirely to getting photos out in one form or 
another. There are also a growing number of publish 
service options. Finally, there’s the tried-and-true Export 
dialog. The Export dialog is the real unsung hero of Light-
room, and it’s probably one of the functions you use 
the most. As powerful as the Export dialog is, there are 
a number of ways you can expand its capabilities even 
further, and in so doing make your workflow more effi-
cient. I want to share some of the ways I’ve turbocharged 
my exports through the use of third-party export plug-ins 
(some free and some donationware).

lightroom plug-in manager
All of the plug-ins I’m going to cover are installed using 
the same process and can be managed through the Light-
room Plug-in Manager. Let’s walk through the basics of 
where you can find these plug-ins, how to install them, 
how to remove them, and then how you can use some 
of them. 

To access the Plug-in Manager, go to File>Plug-in 
Manager. You’ll see that you already have a few plug-ins 
installed that come with Lightroom. At the bottom left 
of the Plug-in Manager is a button that takes you to the 
Plug-in Exchange where you can try (and buy) many dif-
ferent types of add-ons for Lightroom and other Adobe 
products. There are some useful ones there to check out, 
but my go-to plug-ins can all be found over at the Pho-
tographer’s Toolbox (www.photographers-toolbox.com). 
No matter where you get your plug-ins, here are the 
steps for installation:

step one: If you’re in the Plug-in Manager, click Done 
to exit. Download the file to your computer and unzip it 
to access the plug-in file, which will have an LRPLUGIN 
file extension.

step two: Place a copy of that LRPLUGIN file in a folder 
of your choosing. A good tip I picked up from John Beard-
sworth at www.lightroomsolutions.com is to store files in 
a Dropbox folder so that they’re accessible on multiple 
computers. All that matters is that you know where this 
folder is located.

step three: Open the Plug-in Manager, click the Add 
button, and navigate to the LRPLUGIN file. Click the Add 
Plug-in button to add it to the manager.

All of the plug-ins I’ll mention have a free trial version avail-
able (or are simply free), and the full version only requires 
a donation in any amount of your choosing (an amazing 
deal). After adding the plug-in to the manager, you’ll see 
if it has any special configuration requirements or a place 
to add the serial number for the full version. On the left is 
a green light next to the plug-in’s name that indicates it’s 
installed and running. That’s all there is to it. To remove a 
plug-in added in this way, click the Remove button in the 
Plug-in Manager. Removing from the manager doesn’t 
delete the LRPLUGIN file, so you’ll need to do that manu-
ally outside of Lightroom.

making exports zippy
I deliver files in compressed ZIP format all the time. It’s 
such an easy and universally useable format for send-
ing files in a neat package that it has become habit for 
me. There’s a cool plug-in at the Photographer’s Toolbox 
called Zip Exporter that allows you to compress your pho-
tos into a ZIP file right in the Export dialog. You can even 
(optionally) configure the plug-in to upload that ZIP file 
to an FTP server as part of the process. The most com-
mon way I use it is to export the ZIP file to a folder in my 
Dropbox account, and then I can easily send a link to that 
ZIP file via an email. 

Begin by selecting the photos you’d like to export, then 
click the Export button at the bottom left of the Library 
module. In the Export dialog, choose Zip Exporter from 

www.photographers-toolbox.com
www.lightroomsolutions.com
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the Export To drop-down menu to access the panels for 
this plug-in. The only new panel provided by this plug-in is 
the one on the top named Zip Exporter. This is where you 
choose the location for this ZIP file to be created. I chose 
a Dropbox folder, but it’s entirely up to you. Once you’ve 
chosen the location, all you need to do is enter a name for 
the ZIP file itself before configuring the remaining panels 
based on your export needs for file type, size, color space, 
etc., as you would for any export. Once configured the 
way you want it, I highly recommend that you click the 
Add button under the Preset window to save those set-
tings as an export preset, which is a huge time saver for 
any repetitive type of export you may have.

An additional option some of you may find helpful 
is the ability to also send this file to an FTP server. I’ve 
done this to make downloads available from my web-
site and have a separate export preset for those times. 
The only difference here is that you need to have access 
to an FTP server and you need to know the username 
and password. Armed with that information, check 
the Send Exported Archive to an FTP Server box, then 
click the Destination drop-down menu, and select Edit 
to enter your FTP credentials (consult your Web host if 
you’re not sure). If you’ve set up the Web module to 

upload to your website, this will look familiar. If not, 
you simply enter your information and click OK (though 
it’s smart to click the Preset drop-down to save your 
settings for reuse). Now you can configure the remain-
ing panels and have that ZIP file uploaded to an FTP as 
part of the bargain. 

ftp for free
Speaking of FTP, there are other times when I need 
to upload a series of photos to my FTP server without 
compressing them into a ZIP file, and it just so hap-
pens that Adobe has a free FTP export plug-in you can 
grab for that purpose. This plug-in is packaged (buried) 
in the Lightroom Developer Center as part of the soft-
ware developer’s kit (SDK). Head over to www.adobe. 

com/devnet/photoshoplightroom.html and click the link 
for the Lightroom 5 SDK. At the bottom of the license 
agreement page, click the Agree and Download Adobe 
Photoshop Lightroom 5 SDK link, then unzip the con-
tents. The folder we want is named ftp_upload.lrdev-
plugin, located in the Sample Plugins folder. Copy that 
folder to where your other plug-ins are stored, add it via 
the Plug-in Manager, and click Done. I changed the file 
extension to LRPLUGIN first (you can do this in Finder 
or Windows Explorer), but the LRDEVPLUGIN extension 
should work, too.

Once added to the Plug-in Manager, select the pho-
tos you’d like to upload and click the Export button. In 
the Export dialog, choose FTP Upload from the Export To 
drop-down menu. The only new panel you’ll see is FTP 
Server down at the bottom of the Export dialog. Click the 
Destination drop-down menu, choose Edit, then enter 
your FTP server information in the Configure FTP File 
Transfer dialog (it works the same as the FTP destination  
I just mentioned before). Now you’re ready to go. 

lr/blog
The last plug-in I’ll highlight gives you the power to 
create a blog post right from the Export dialog. This 
one is also found at the Photographer’s Toolbox and 
is donationware. Once installed, you’ll find the LR/Blog 
in the Export To drop-down menu. There’s a little more 
required for set up with this plug-in, and the most obvi-
ous requirement is that you need to have a blog. I use 
it with a WordPress blog, but other platforms are sup-
ported (check the LR/Blog page at the Photographer’s 
Toolbox for details). 

Enter your blog’s URL, username, and password in the 
LR/Blog panel. From there you can choose to create a 
full-fledged blog post or you can upload photos to your 
blog’s media gallery for later use (this is what I do most) 
via the LR/Blog Post Creation panel. 

Aside from the novelty of creating a blog post from 
the Export dialog, there’s a lot of power packed into this 
plug-in. Using tokens that pull data from the photo’s own 
metadata, you can automate the insertion of various data 

points about your photos, such as exposure info, GPS, 
title, caption, etc. It uses a template system for the cre-
ation of the posts and is highly customizable. If you like 
to blog about your photos and you’re not using this, then 
you’re missing out. ■

www.adobe.com/devnet/photoshoplightroom.html
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Impression is the latest in a long line of plug-ins 

from Topaz Labs. It was released in September 

2014, but at the time of writing, it was already 

at version 1.1.1, which added new features over 

version 1. So what does Impression do? Quite 

simply, it converts photos to digital paintings. 

Not just any plain painting, but ones based on 

real brushstrokes, lighting, and textures.

topaz impressionMaximum 
Workflow 

B Y  S E A N  M c C O R M A C K

While the name Impression does come from the Impressionist 

movement with the works of Cézanne et al, there are far more 

styles available. Go to topazlabs.com/downloads to get your 

free 30-day trial. 

getting started
Install the plug-in to get started. Per the install instructions, run 

Impression to automatically install the External Editor preset for 

Lightroom. Make sure to restart Lightroom so it picks up the 

preset. By way of aside, Matt Dawson has a Lightroom script for 

quick restarts at http://thephotogeek.com/lightroom-power-

nap-restart-script. 

When you do the first run of Impression, click on Take the 

Tour to get an overall feel for the plug-in. This is a basic look, 

but it will help before you get into the more detailed look we’re 

doing here. 

Once Lightroom has restarted, you’ll have a new preset in the 

Photo>Edit In menu. This is also available by Right-clicking on the 

photo you want to edit. The photo I’ve chosen here is from the 

Dragons street theatre group and was selected because it has a 

good range of color to show off the painting effects.

[KelbyOne members may download the file used in this tuto-

rial at http://kelbyone.com/magazine/issue/january-2015. All 

files are for personal use only.] 

the interface
When Impression loads, we’re presented with the main image (1)  

with a preset applied. On the right is a bank of featured pre-

sets from which to choose (2). To get a feel for the range  

of looks available, click each preset. To see all the available pre-

sets, click the Featured drop-down menu and choose All Effects. 

The presets are also split into smaller collections of related looks. 

You can use the Arrow keys to scroll up and down through  

the presets.

Generally, each preset is named for the painting or drawing 

style within, and often named for a specific painter. As you select 

each preset, a purple bar will load across the top of the image, 

letting you know the process’s progress. I’ve gone for Impasto  

I (found in both the Featured and Impressionistic sets). It’s almost 

instant on my MacBook Air, but slower on the older Mac Pro. 

In the preview control area (3), you can choose from five 

views: after, before/after side-by-side split view, before/after top-

and-bottom split view, before/after side-by-side full view, and 

before/after top-and-bottom full view. Next is the zoom section, 

which reveals a slider on hovering. Once zoomed in, a navigator 

window appears, allowing you to choose what part of the photo 

to view. In addition, you can click on the up and down arrows 

beside the zoom percentage. There are also Fit, 100%, Fill, and 

Maximum options in the View menu in the Menu Bar. When 

in the default after view, clicking the Original button shows the 

before view, as does clicking on the photo itself.

To finish the interface housekeeping, at the bottom left we 

have a Strength slider (with a manual percentage entry field) 

and a drop-down menu of blend modes (4). Strength acts like 

an opacity control between the processed and original photo, 

while the blend modes emulate those of Photoshop, albeit with 

a smaller selection.

selective parameters
With that out of the way, let’s get into the selective parameters. 

Our selected preset has a blue border and a little black circle 

with sliders. Clicking the selected preset, or the Show Param-

eters icon (sliders) to the right of the presets drop-down menu, 

topazlabs.com/downloads
http://thephotogeek.com/lightroom
http://kelbyone.com/magazine/issue/january
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will open the selective parameters. 

Alternatively, press P. One really 

good thing about Impression is 

that no matter what preset you 

start from, you have access to a 

full range of controls, not limited 

like in some other paint programs. 

There are four panels in Impression: Stroke, Color, Lighting, and 

Texture. Clicking on a panel header will collapse it or expand it.

the stroke panel
The Stroke panel contains all the 

controls relating to the brush style 

you wish to emulate. Because of 

the versatility of the tools, you 

need to try low, medium, and 

high values of each to understand 

them. This plug-in is loads of fun, 

so get playing with the sliders! 

We’ll do a specific look at the end 

once we’ve examined the tools.

The Brush section contains 17 

different brush types from pencil 

to chalk to palette knife, among 

others. These form the basic looks 

for each painting style. Each type 

was created from a real brush or 

pencil stroke that was scanned and masked for more realistic 

painting effects.

Brush Size intelligently changes the size of the brush. For 

example, if we push it to 1.00, the sky shows large brush strokes, 

but we retain small details in the leaves. This alone sets it above 

many paint programs. 

Paint Volume acts like the pickup of paint on a brush. More 

gives the impression of thicker brush strokes with strong 

brush edges.

Paint Opacity controls the layering of paint on paint. Lower 

values show more of the original image but on the underlying 

texture—think of it as the paper or canvas that you’re painting 

on. Higher amounts act like layering paint on top of paint. 

Stroke Rotation and Rotation Variation control the angle of 

the brushstroke, and how often it changes. This is useful for get-

ting a more organic feel to the photo as a painting, but high 

values look a little sloppy. Rotation Variation only appears when 

Stroke Rotation is moved from 0. 

Stroke Color Variation adds more color to each stroke. At 

high values, the colors bear no relation to the original colors 

in the photo. Quite fun, actually. The figure below shows 

high values of Stroke Rotation, Rotation Variation, and Stroke 

Color Variation.

Spill controls how much the paint bleeds into other strokes. 

High values have the paint spill well beyond nearby paint strokes.

Smudge smoothes outlines and creates wavy effects at 

higher values—very visible in the Liquid Lines presets in the 

Modern set.

Coverage controls how 

much of the paper is painted 

on. For most paintings, you 

want full coverage, but for 

sketches and watercolors, the 

whole paper often isn’t used. 

When Coverage is dropped 

from full, two additional 

controls appear: Coverage Transition, which acts as a feather-

ing between the background texture and the painted area, and 

Coverage Center, which controls the midpoint of the painting.

the color panel
The nine tiles in the Color panel control the hue, saturation, 

and lightness (HSL) of the overall image and the individual 

color bands within (see next page). Click on the tile of the 

color that you want to edit. Hue controls the shade of the 

color, while Saturation controls the strength. Lightness con-

trols how light or dark the color is. While it’s easy to see what 

the overall HSL sliders do, it’s not as easy to picture where the 

individual colors affect the photo. 

Fortunately, Impression has a little cheat to help. When 

you hover over any of the color tiles, hatching appears on the 

parts of the photo it will affect. Hovering over the Magenta 

tile shows a great deal of our dragon will be affected by 

changing the HSL sliders.

the texture panel
Texture controls the background of the image, that is, the 

material the photo gets painted onto. The Strength slider con-

trols the opacity of the selected texture. Size controls the scale 

of the texture; for example, a 24x16" print would need a differ-

ent texture size than a 6x4" print if you want it to look realistic. 

Next are the textures, with varied styles from paper to brickwork, 

and even cardboard. The inclusion of brickwork makes Impression 

useful for creating painted backdrops for composite images.

Background Type switches between the original texture and 

a colorized version. This color can be selected from the Back-

ground Type swatch that appears when Solid is selected. This 

matters for the Coverage settings in the Stroke panel, as the non-

painted areas will take on this color, as shown here. 

the lighting panel
Lighting is more than changing 

the luminosity of the painting. 

The Brightness slider is more of 

a highlight control, while try-

ing to retain darker colors. More 

extreme values will brighten the 

whole image. Contrast, as always, 

works to darken shadows and 

boost highlights when increased, 

or flatten out the tone of an 

image when decreased.

Vignette darkens the edges, 

and isn’t a typical paint control, but can help bring focus 

into the center of the image. As with other sliders, chang-

ing Vignette adds more controls: Vignette Transition, which 

feathers the vignette, and Vignette Center, which sets the 

midpoint of the vignette. 

Light Direction is interesting. Rather than a painting control, it 

simulates the light that falls on a painting. For oils it creates shad-

ows from the paint, so the direction can have a radical effect on the 

look of the painting. Placed in the center, the brushes flatten out 

and lack texture. Even with textures, like canvas for example, the 

underlying texture also gets flattened out (see below). 
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saving presets
One of the collections available in the presets drop-down menu 

is My Presets, an indicator that you can make your own. It’s 

easy. As soon as you change a setting, a + icon appears beside 

the name of the current preset (as well as an asterisk to indicate 

that the settings have changed). Click the + to bring up a save 

dialog. Give the preset a new effect name, and choose which 

collections you want it to show in. 

preferences
Impression has a basic Preferences dialog as of version 1.1. 

You can opt to have an example image on start-up. Untick-

ing Start with Preset Panel will open Impression with the selec-

tive parameters panels active. For Processing Options, you can 

choose to Update Slider Value While Dragging, and Enable 

High-Resolution Processing. 

let’s get practical
Impression is so much fun that I can’t finish without doing some-

thing specific to my dragon. Follow along with the file download.

1. From the Impasto I preset, select Brush Type04.

2. Bring Stroke Width and Length to 0.55.

3. Set Smudge to 0.70 to get a wavy effect. 

4. �Click the Magenta tile (the rightmost one) in the Color panel 

and set Hue to –0.55, Saturation to 0.35, and Lightness to 

–0.47 to make it a rich blue. This cool tone complements 

the yellow underbelly.

5. Set the Light Direction to top center for a midday sun look. 

6. �In the Texture panel, choose Brick Weathered. The wall 

looks like the side of a tower, so increase the Size to 1.00 

to make it look more like a schoolyard wall.

That’s it. Now you have a cool mural that’s our featured 

image! ■ 

graduated filter tips
The shortcut to activate the Graduated Filter is M. When the 

tool is activated you can begin setting the adjustment using the 

sliders in the Graduated Filter panel, or you can set those after 

you’ve defined the area that will be affected.

Start dragging to begin the adjustment; stop dragging to end 

the adjustment. To constrain the gradient so it doesn’t wobble as 

you’re dragging it, hold down the Shift key.

Everything in between these two points is where the adjustment 

fades from full strength to nothing. If you need to invert the gradi-

ent after you’ve drawn it, the shortcut is the Apostrophe key (’).

Adjust all of the applied sliders at once by Option-dragging 

(PC: Alt-dragging) on the circular pin. Drag left to move the slid-

ers closer to the default position, thus minimizing the effect, and 

drag right to increase the effect.

radial filter shortcuts
Press Shift-M to activate the Radial Filter. By default any Radial Fil-

ter adjustment is applied to the area outside the radial shape you 

define. To invert the mask and have the adjustment applied to 

the area inside the circular or elliptical shape, the shortcut is the 

same as for the Graduated Filter, the Apostrophe key (’). There’s 

also an Invert Mask checkbox at the bottom of the control panel 

for this tool.

Dragging on the side handles will change the size and shape 

of the Radial Filter by adjusting the side you click on, as well as the 

opposite side. Option-drag (PC: Alt-drag) on a handle to adjust 

only that side. Shift-drag on a handle to adjust all sides with the 

point of origin being the center of the radial shape. Shift-Option-

drag (PC: Shift-Alt-drag) on a handle and the entire shape can be 

affected with the point of origin being the opposite handle.

To make a copy of an adjustment, drag on the pin while press-

ing Command-Option (PC: Ctrl-Alt). ■

The Adjustment Brush and the Graduated Filter are the core of 

the localized editing capabilities in Lightroom. There are more 

precise ways to create a mask to target a specific area in Photo

shop, of course, but in many cases, the tools in Lightroom are all 

that you’ll need. This issue, we’ll take a look at some essential 

tips for these tools.

adjustment brush shortcuts
Press K to open the Adjustment Brush panel. The same key will 

also close the panel when you’re done. To switch a brush to 

Erase mode, hold down Option (PC: Alt) as you use the brush. 

The letter O on the keyboard toggles between showing and hid-

ing the colored overlay of the brush mask. To change the color of 

the overlay, go to Tools>Adjustment Brush Overlay.

adjustment brush size and feather
Change the size of the brush by tapping the Left Bracket key ([)  

to make the brush smaller and the Right Bracket key (]) to make 

it larger.

With a slight addition to this shortcut, you can change 

the Feather setting for the brush to make it harder or softer. 

Shift plus the Left Bracket key reduces the Feather value, mak-

ing the brush edge harder; Shift plus the Right Bracket key 

makes the brush softer. The two circles of the brush cursor 

reflect the hardness of the brush. The farther apart they are, 

the softer the brush is, while the circles being closer together 

indicate a harder edge. The space between the circles repre-

sents the feather zone where the brush coverage transitions 

from 100% to 0%. A higher Feather setting will have a larger 

feather zone.

configure different adjustment  
brush tips
The A and B but-

tons allow you to 

create two differ-

ent brushes that 

can be used with a 

single brush adjust-

ment. For example, 

you might want a large, soft-edged brush with a high Feather 

setting and then a smaller brush with a harder edge for more 

accuracy. Only the brush settings for Size, Feather, and Flow 

apply to the A and B brushes (i.e., you can’t have a B brush with 

a different combination of adjustment settings).
ALL IMAGES BY SÉAN DUGGAN
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[KelbyOne members may download the files 
used in this tutorial at http://kelbyone 
.com/magazine/issue/january-2015. All files 
are for personal use only.] 

STEP ONE: Open the image of the leaping dancer. Activate the 

Quick Selection tool (W) and paint over the subject to produce a 

rough selection. Use the Left and Right Bracket keys to resize the 

tool as necessary to select smaller regions. To eliminate areas where 

the selection spills beyond the edges, hold Option (PC: Alt) and paint 

the selection away. Don’t worry about selecting fine hair details or 

patches of hair where the backdrop is visible. We’ll deal with the hair 

in a later step.

In skin and clothing regions where the Quick Selection tool creates 

a bumpy or errant selection, activate the Polygonal Lasso tool (nested 

under the Lasso tool [L] in the Toolbox), click the Add to Selection or 

Subtract from Selection icons in the Options Bar, and clean up the 

bumps. Click the Add Layer Mask icon (circle in a square) at the base 

of the Layers panel to turn the selection into a mask.
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STEP TWO: Open the exploding powder image, and activate the 

Move tool (V). While pressing Shift, drag the dancer into the ex-

ploding powder photo. The exploding powder is a little too big 

and will benefit from a little rotation. In the Layers panel, click the 

lock icon next to the Background layer to unlock it. Press Com-

mand-T (PC: Ctrl-T) to activate Free Transform. While pressing 

Option-Shift (PC: Alt-Shift), grab a corner handle and scale the 

powder down slightly. Now hover just outside the bounding box 

and rotate the powder so the fragmented blast on the right side 

looks like it’s exploding from her abdomen. Press Enter to commit 

the transformation.

While pressing Command (PC: Ctrl), click the Create a New 

Layer icon at the base of the Layers panel. This creates a new layer 

below the active one. Press D to set the default Foreground and 

Background colors. Press Option-Delete (PC: Alt-Backspace) to fill 

the new layer with the Foreground color (black). Use the Crop 

tool (C) to eliminate excess black.

 C reating a COMPELLING photo composite 
is as much about finding the right assets 
as it is about the process of blending them 
together. If you’re unable to capture your 

own assets, stock image sites are treasure chests 
for images, as well as INSPIRATION. While hunt-
ing for the images used in this issue’s tutorial,  
I encountered dozens of stock photos that sparked 
ideas. When I finally stumbled across the images 
we’ll use, I was so CAPTIVATED by the brilliant col-
ors and dynamic shapes that I couldn’t wait to begin 
exploring the possibilities. This level of enthusiasm 
is key to crafting a composite that stops viewers in 
their tracks and elicits an emotional response. 

Our goal is to blend the leaping dancer with the 
prismatic powder so it appears as though she is 
actually inside the explosion. To accomplish this, 
we’ll need to extract the dancer, balance the tones 
and colors, blend the powder into the edges of the 
dancer using a custom brush, and add punch to 
the overall scene.
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layout design: taffy clifford
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STEP FIVE: Although the tones and colors look pretty good, 

the dancer will benefit from some subtle shifts. With the selection 

still active, choose Layer>New Adjustment Layer>Curves, and 

click OK. From the Properties panel flyout menu, choose Auto- 

Select Targeted Adjustment Tool. This changes the default be-

havior of the On-Image Controls to on. Hover over a highlight 

with detail on the dancer, and click-and-drag up to add light. Be 

subtle. Now click on a shadow with detail and drag up to open 

the shadows just a little. 

If there’s a noticeable line in the hair caused by the orig-

inal mask, fix it by painting with a large, soft-edged, white 

brush at 100% Opacity. Don’t worry about being precise.  

A little extra light on the powder behind the dancer’s head 

is acceptable.

Now let’s address the color. Pull yet another selection from 

the original dancer’s (Layer 1’s) mask by Command-clicking (PC: 

Ctrl-clicking) it. Choose Layer>New Adjustment Layer>Color Bal-

ance, and click OK. Add a touch of Cyan and Green to the Mid-

tones to reduce the red light on the dancer’s skin and clothing.

STEP SIX: Here’s where the fun really begins. We’ll cus-

tomize a brush from QBrushes to blend the exploding pow-

der with the edges of the dancer. Begin by Option-dragging 

(PC: Alt-dragging) the exploding powder layer (Layer 0) to the 

top of the layer stack (Option-dragging [PC: Alt-dragging] 

makes a copy of the original layer [Layer 0 copy]). Add a black-

filled mask by Option-clicking (PC: Alt-clicking) the Add Layer 

Mask icon at the base of the Layers panel.

Now visit http://qbrushes.net/xplosion-brushes and down-

load the free Xplosion Brushes. After placing the brushes in a 

meaningful location on your hard 

drive, return to Photoshop and 

activate the Brush tool. Open the 

Brush Preset Picker in the Options 

Bar and choose Load Brushes from 

the flyout menu (gear icon). Nav-

igate to the Xplosion Brush set 

and click Open. In the Brush Preset 

Picker, choose the brush labeled 

xBLOW2 (255 pixels). For the prac-

tice file, you’ll want to drop the 

size of the brush to about 50 px.

In the left side of the Brush panel  

(Window>Brush), click on Shape 

Dynamics. Slightly increase both the 

Size and Angle Jitter values. 

Now click on Scattering. Increase 

the Scatter value to approximately 100%. 

Set the brush to 50% Opacity in 

the Options Bar and paint over the 

dancer’s edges to mingle the pow-

der with the dancer. To build the 

effect in desired regions, paint more than once.

STEP THREE: Let’s refine the clothing and skin edges of 

the dancer so they exhibit believable softness and show no 

evidence of fringing. In the Layers panel, activate the mask 

for the dancer layer (Layer 1). Choose Select>Refine Mask. 

Set the View menu to On Layers. Drag the Feather slider to 

0.8 px to add a touch of softness to the edge. Move the 

Shift Edge slider left until all fringing is eliminated. Try not 

to shift the edge any farther than necessary as this may 

result in loss of too much edge. Set the Output To menu to 

Layer Mask, and click OK. 

STEP FOUR: Even though the dancer was captured on a white 

background, producing an accurate selection of her hair is ex-

tremely challenging. Fortunately, since she was captured on a 

white background, there’s a marvelous trick for dealing 

with her hair. With the subject layer active, press Com-

mand-J (PC: Ctrl-J) to duplicate it. Turn off the visibility 

of the original dancer layer (Layer 1) by clicking on its Eye 

icon. Right-click on the duplicate layer’s mask thumbnail 

(Layer 1 copy) and choose Delete Layer Mask. Since this is 

a reasonably dark-haired model in front of a white back-

drop, change the blend mode from Normal to Multiply. 

Notice how this immediately solves the hair edge problem. 

In fact, Multiply blend mode gives the dancer an over-

all believable appearance—with two small exceptions. 

We need to eliminate the barely visible line at the perime-

ter of the dancer layer and we need to selectively restore 

light to critical areas of the dancer. (If you have trouble 

locating the perimeter line, turn the visibility of the dupli-

cated dancer layer off and on.) To eliminate the perimeter line, 

click the Add Layer Mask icon at the base of the Layers panel, 

and switch to the Brush tool (B). Using a large, soft-edged black 

brush at 100% Opacity and Flow in the Options Bar, paint the 

line away. To accomplish this with just five clicks, hold the 

Shift key and click on each corner, finishing with a click 

on the original corner. Pressing Shift paints a straight line 

between each click.

To restore light to the dancer, activate the original 

dancer layer (Layer 1) and press Command-J (PC: Ctrl-J) 

to duplicate it (Layer 1 copy 2). Turn on visibility of the 

duplicate layer and drag it to the top of the layer stack. 

Activate the mask, press D, then Command-Delete (PC: 

Ctrl-Backspace) to fill the mask with the Background color 

(black). Load the original dancer’s (Layer 1’s) mask as a 

selection by Command-clicking (PC: Ctrl-clicking) it. Using 

a white brush set to 50% Opacity, paint over areas that 

benefit from additional light. Don’t be afraid to paint over 

interesting areas more than once to add more light. 
 

http://qbrushes.net/xplosion-brushes
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STEP SEVEN: To accentuate the most interesting features of 

the dancer, we’ll perform a little dodging and burning. Option-click 

(PC: Alt-click) the Create a New Layer icon at the base of the Layers 

panel. In the New Layer dialog, change the Mode drop-down menu 

to Overlay, check the box labeled Fill with Overlay-Neutral Color 

(50% Gray), and click OK. Borrow the selection from the original 

dancer’s (Layer 1’s) mask by Command-clicking (PC: Ctrl-clicking) it. 

Using the default, soft-edged, white brush at 10% Opacity, paint 

over all existing highlights that benefit from more light. Build the 

effect where desired. Now press X to swap the Foreground color to 

black and paint over existing shadows to add definition to edges. 

Press Command-D (PC: Ctrl-D) to deselect.

STEP EIGHT: An image with details like this really benefits 

from additional clarity. While holding Option (PC: Alt), choose 

Layer>Merge Visible. This creates a composite layer at the top of 

the stack. Choose Filter>Convert for Smart Filters. Now choose 

Filter>Camera Raw Filter. Adjust the Clarity setting until the  

image really pops.

Click OK to exit the Camera Raw dialog. Here’s a look at the 

completed colorful composite. 

Compositing provides limitless fun 
because it challenges us to think cre-
atively while calling into play a nearly 
endless variety of Photoshop techniques. 
Keep in mind that the original assets you 
choose set the tone for the entire pro-
cess. Find images that get your pulse 
racing and you’re already on your way 
to exhilarating possibilities. ■ 

http://kelbyone.com/marketplace/books/
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Step One: With a basic frequency separation approach, you’ll 

end up with a high-frequency layer that looks gray, and is typi-

cally set to Linear Light blend mode. Add a Curves adjustment 

layer above the high-frequency layer (Layer>New Adjustment 

Layer>Curves). Hold Option (PC: Alt) and click on the boundary 

between the Curves layer and your high-frequency layer in the 

Layers panel to clip them together. Clipping the adjustment layer 

ensures it only affects the high-frequency information.

Step Two: The first thing I do with the Curves adjustment is to 

open the Properties panel (Window>Properties) and click in the 

middle of the graph along the line. The center point is Input: 125 

and Output: 125. This helps keep you from adjusting the overall 

tonality of the image so you can work just on the sharpening 

effect. The next thing to do is set the blend mode of the Curves 

adjustment layer to Vivid Light. This will probably appear to be 

too strong, so we’re going to dial back some settings in a bit.

Tip: If you click on a point in the Curves preview in the Proper-

ties dialog, you can manually enter values in the Input and Out-

put fields at the bottom of the panel.

Step Three: Since the basic setup is in place, let’s take a look 

under the hood and see what we have before we start fiddling 

with the knobs. The high-frequency layer is created by removing 

nearly all color information, leaving behind edges and smaller 

Many portrait retouchers are familiar with a technique called 

frequency separation. It’s used to split color and texture infor-

mation into separate layers for better control over each (see 

Episode 386 of Photoshop User TV at KelbyTV.com, about  

14 minutes in with Pete Collins). As part of this technique, you 

get a free high-frequency layer that isolates the fine texture in 

your photograph. If you aren’t familiar with frequency sepa-

ration, I encourage you to go watch Pete’s presentation. Go 

ahead, I’ll wait.

Note: The quick-and-dirty alternative to frequency separation 

for purposes of this demonstration is something you probably 

have seen at some point: high-pass sharpening. To create a high-

pass sharpening layer, duplicate your photograph’s Background 

layer (Command-J [PC: Ctrl-J]), then go to Filter>Other>High 

Pass and apply a small Radius setting of about 3–8 pixels. You 

want to end up with a gray layer where you can really only see 

the smaller details in your image, but not so small that all you get 

is noise. In the Layers panel, set this duplicate layer’s blend mode 

to Hard Light for this exercise. The Curves adjustment layer will 

get clipped to this layer as described in the main body of this 

article. Your results will be a little different, but the basic idea is 

exactly the same.

SCOTT VALENTINE
Photoshop Proving Ground 
 sharpen with curves

H O W  T O  › ›

features. The details of how this happens aren’t important right 

now; just take a look at the fact that the layer is mostly neu-

tral gray, while the edges and features are lighter and darker 

with some bits of color. The blend modes we chose ignore gray, 

which effectively behaves like a mask for those areas.

Step Four: Now that we know the blend modes ignore gray, 

we’re free to play with everything not gray in the layer. The 

Curves adjustment is there to change the relative contrast 

between these not-gray areas. Add two control points and cre-

ate this basic contrast shape. The effect is even stronger now 

with very bright, blown-out highlights. Things are probably look-

ing very unattractive. Fortunately, we’re able to take advantage 

of some additional features to deal with this.

Step Five: The most obvious choice would be to lower the 

Opacity of the Curves adjustment layer, but we don’t want to be 

obvious just yet. Instead, we do want to refine what parts of the 

high-frequency layer are adjusted by the curves. To the right of the 

Curves label in the Layers panel, double-click to open the Blending 

Options in the Layer Style dialog. Down in the Blend If section, start 

dragging the white triangle under This Layer to the left. There will 

be little to no change until you hit some point, different for every 

image, where the highlights you just created simply disappear.

At the point where the highlights change, stop dragging and 

hold down the Option (PC: Alt) key, then drag the left half of 

the slider further left and move the right half back to the right 

until the highlight edges are soft, anywhere from 20 to 70 levels 

between them or more. Splitting the slider lets you feather the 

effect of blending, and allows the transition between affected 

regions to be softer. Click OK.

Step Six: Okay, now go ahead and lower the Opacity of the 

Curves adjustment layer until you like the effect. You’ll prob-

ably have to tweak the settings back and forth a few times, 

but that’s perfectly fine. In fact, that’s one major benefit of this 

technique—you aren’t locked in to the sharpening result. And 

don’t forget that you can do this multiple times with various 

settings if you use the adjustment layer mask to paint in only 

the areas you want sharpened.

Regular readers of this column (you know who you are) are familiar with my penchant for putting familiar tools in 
unfamiliar situations. This time I’m bolting a Curves adjustment layer onto a popular portrait retouching technique 
in order to—ready for this?—sharpen your images!

KelbyTV.com
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The Curves adjustment is only 

changing the boundary from 

gray to light, not actually apply-

ing sharpening. The result is 

similar, though. In an upcoming 

column, I’ll talk about edges in 

some detail, but for now just real-

ize that this technique is not truly 

sharpening so much as adjusting 

local contrast in a very fine way.

Traditionally, sharpening is 

done as one of the last steps 

before final output. That’s gen-

erally good advice, so consider 

this particular approach as 

intermediate sharpening. I like 

to use it after I’ve done a first 

pass at cleaning up the high- 

frequency layer for major blem-

ishes because it gives me a 

good idea of when I’m starting 

to overdo a skin correction. If 

you really crank up the contrast 

curve, you can see when tex-

tures don’t match or blend well, 

then you can reduce the con-

trast back to reasonable levels.

Oh, one last thing, don’t get 

locked into this being only for 

portraits. Check out this before 

and after of leaves. ■

Before

Before After

After

http://kelbyone.com/marketplace/books/
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Product Reviews

Turn Your Picture into a Beautiful Engraving 
 Review by Jay Nelson

Superior Replacement for Retired  
Oil Paint Photoshop Filter
 Review by Jessica Maldonado

 Topaz Impression

Engraver III is a plug-in for Photoshop that can apply a wide variety 

of engraving-like effects to any image, including photos, logos, or 

even text. It works on any 8-bit RGB or CMYK image, but seems 

optimized for Photoshop files sized from 2–6 MB. (While sliders 

let you adjust the line effects for larger or smaller images, that 

process quickly becomes tedious.)

Dozens of presets help you get started, from standard engrav-

ing styles to cheesecloth, rubber stamp, wood, linocut, and 

leather. The success of the effect depends greatly on the subject 

matter: Architectural and nature photos work well, as do line-art 

logos. After choosing an effect, you can customize almost every-

thing about it using sliders and dials, and even use randomizing 

controls to make it look more like it was made by hand. 

A third customizing panel lets you control the color palette 

used in the effect, the paper texture and color beneath it, and the 

depth of the stamping. These are tremendously useful when cre-

ating embossed effects or when imitating old-fashioned prints.

For additional flexibility, you can add a second layer of engrav-

ing that contains a different effect. When you find a combination 

Topaz Labs says it’s excited about Impression because it’s the first 

product to help you create real, authentic art. Photographers may 

balk at this statement, but let’s acknowledge that Topaz Impres-

sion is a photo-manipulation product, and presume they define 

“authentic art” as painterly art with a capital A. 

Impression works as a standalone editor or Adobe Photoshop 

plug-in. If you want to add stylized looks to evoke a mood, fit a 

particular design, or sell extra prints to art-loving customers, this is 

a good tool: One that more than fills the void left by the removal 

of the Oil Paint filter in Photoshop CC 2014. 

When you open an image in Impression, it prepares previews 

of its more than 100 presets. Choose one as a starting point, and 

tweak the sliders to your heart’s content. Or start from scratch 

with 17 realistic brushes and thousands of ways to apply them. It 

takes a sensitive eye to select increments of each adjustment as 

it relates to your subject and resolution, but patience and experi-

mentation will yield lovely results. 

According to Topaz Labs, they “designed Topaz Impression to 

use the same method that great painters use: paint brushstrokes 

of settings you like, you can save them as a custom preset for 

future use.

Engraver III may do what you need, but if you’re looking for an 

engraving plug-in, you might also want to take a look at Cutline 

from Andromeda Software ($89), which produces different kinds 

of effects. Both offer a free trial period. ■

one at a time. (It just does this very fast!) Impression can paint 

over 10,000 brushstrokes in less than a second, all while com-

pletely following your artistic direction.” Whatever mathematical 

wizardry drives their algorithm under the hood, it does seem to 

do that, with strokes that move with the nuances of your images. 

I’d love to load Impression’s brushes into Photoshop so any 

masking or edits could match. History states and section toggles 

would be welcome, but overall, it’s great fun and works well. If 

you can sell a few “authentic art” prints for the price of this appli-

cation, it will pay for itself before you can say, “artiste!” [For a 

tutorial on using Topaz Impression, see “Maximum Workflow” on 

p. 92.—Ed.] ■

 Engraver III

Company: AlphaPlugins	 Price: $74.95 (Upgrade: $25)

Web: www.alphaplugins.com	 Rating: ◆ ◆ ◆

	 Hot: Variety of effects; useful color, texture, and stamping 

	 Not: Previews are only accurate at 100% view

Company: Topaz Labs	 Price: $99.99 

Web: www.topazlabs.com	 Rating: ◆ ◆ ◆ ◆

	 Hot: Easy to use; many great presets make nice starting points

	 Not: Waiting while every preset loads is tedious 

Company: onOne Software, Inc.	 Price: $149.95 (Upgrade: $99.95)

Web: www.ononesoftware.com	 Rating: ◆ ◆ ◆ ◆ ◆

	 Hot: Speed; masking tool; cloud-based storage support 

	 Not: 

Updated Photo Editing and Effects Software
 Review by Daniel M. East

Photo Corrections the Easy Way
 Review by Erik Vlietinck

 Perfectly Clear 2 

onOne Software has always offered some of the most fun Photo

shop tools that produce outstanding results, making it difficult 

to find fault with any new version, and Perfect Photo Suite 9 

Premium is no exception. onOne has incorporated their most 

popular tools into an easily navigable suite. By not only improving 

performance, but also adding even more user-friendly features 

for the tasks photographers do most, onOne shows us that it’s 

now a more portable world with more control over your images 

no matter where you are.

Without question, the first thing that jumps out is the blazing 

speed of image previews, and you can also see more accurately 

than in previous versions what you’re going to get. The common-

sense interface helps improve workflow, too, because recognizing 

the function is simply based on the control’s familiar icon, using 

standard indicators. Perfect Photo Suite 9 isn’t just about correct-

ing your photos, it’s also about improving them: creative changes 

to produce what the mind’s eye might see in a way that takes 

images and design elements to new levels. 

The standout feature (among many) would have to be the 

updated masking tool. Just outline your object, and you can eas-

Athentech Imaging promises that with the Perfectly Clear 2 plug-in 

you can correct photos in much less time than it would take with 

Adobe Photoshop or Lightroom tools.

I tested Perfectly Clear 2 with Photoshop CS6, and it tackles 

problems mainly with portraits, including sharpness; noise; red-eye 

correction; exposure; skin shine, tint, and blemishes; dark circles; 

and teeth color. I had the impression Perfectly Clear is optimized 

for snapshots taken in Auto mode. 

The Perfectly Clear plug-in for Photoshop and Lightroom has 

its own interface, showing the image on the left and presets and 

adjustment controls on the right. There’s a group of eight presets 

that should cover most of the imperfections found in snapshots. 

The idea is to start with one of the presets and then click on the 

Adjust tab to make further refinements. That’s a good way to work 

quickly through one or multiple images, and having only eight pre-

sets helps you decide which flaw in the photo is most critical.

The Portrait corrections in Perfectly Clear 2 work better and faster 

than Photoshop. The adjustment parameters, however, are fairly 

basic (except for portraits). Landscapes, architecture, and object 

photos can be corrected only with parameters such as Exposure, 

ily eliminate the background in less time and with less fine-tuning 

than any other product of this kind. 

There are too many features to go into here but, rest 

assured, onOne Software continues to set the standard with 

new features, performance, and cloud-based storage compat-

ibility. The software handles each task quickly and easily—in 

both the standalone application and the plug-in editor for 

Adobe Photoshop and Lightroom. 

If you’re not sure, check out the free trial version and try 

before you buy (or upgrade). The proof is in the output and it’s 

fine, indeed. ■

Depth (looked a lot like microcontrast to me), Vibrancy, Fidelity,  

Tint Correction, Sharpening, and Noise.

I found terms used in the interface confusing; for example, 

what does Fidelity correct? It’s said to restore full-color spectrum; 

but what does that mean with respect to, say, a Canon EOS 5D? 

Portrait-enhancement features that stood out were Catchlight, 

Blemish Removal, and Light Diffusion. Face Slimming did what it 

set out to do, but it can easily be overdone. Sharpening is subtle, 

with Perfectly Clear 2 using an algorithm that avoids artifacts even 

with the slider set at full strength. ■

 Perfect Photo Suite 9 Premium

Company: Athentech Imaging	 Price: $149

Web: www.athentech.com	 Rating: ◆ ◆ ◆ ◆

	 Hot: Portrait tools; sharpening can’t be overdone

	 Not: Some features only meaningful for low-end camera shots
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Tinted Filters for Hot-Shoe and Studio Strobes
 Review by Michael Corsentino 

Battery-Powered Studio Light
 Review by Michael Corsentino

Color-Accurate Video- and Photo-Fill LED Lamp
 Review by Erik Vlietinck

Super-Powered Mobile Workstation
Review by Daniel M. East

 Rosco Flash Packs and Filter Kits

Legendary gel and diffusion fabric manufacturer, Rosco Laborato-

ries, which offers more than 1,200 gels and fabrics for photogra-

phers, filmmakers, architects, and the theatrical market, has intro-

duced several new Flash Packs and Filter Kits for hot-shoe flashes, 

larger studio strobes, continuous lights, and LEDs. 

With so many filters to choose from, it can be daunting to 

know where to start or what the results will be (aside from the 

usual suspect filters such as Color Temperature Orange). Realiz-

ing this, Rosco has created an ingenious set of Filter Kits for pho-

tographers and videographers. Organized by their intended use, 

each pack brings together the best and brightest that Rosco has 

to offer, and helps remove the mystery. 

Hot-shoe flash users have four Rosco Flash Packs to choose 

from: the Strobist Collection (created in collaboration with David 

Hobby); the Beauty pack with hand-selected filters to enhance 

skin tones; CalColor for exact color control with primary and sec-

ondary colored filters; and the Digital After Dark pack with spe-

cialized filters for nighttime photography and light painting. Flash 

Pack filters are 1.5x5.5", and sets include two bands for easily 

attaching filters to your flash. 

The mono light space is heating up, and that’s good news for 

consumers. Phottix has a winner on its hands with their recently 

announced Indra500 TTL Light, an on-the-go strobe that’s safe to 

call “the complete package.” Why? Simply because the Indra500 

TTL Light includes all the must-have features for which the masses 

have been clamoring but not getting from manufacturers who’ve 

already come to market with similar offerings and left people 

waiting and wanting.

At 500 Ws, the Indra500 TTL Light is no slouch in the power 

department. Then add TTL capability and built-in triggering for 

both Canon and Nikon DSLRs via Phottix’s Odin TTL Flash Trigger  

technology, and things start to get really interesting. It doesn’t 

stop there. The Indra500 TTL Light is also the first product 

brought to market featuring high-speed sync (HSS), providing 

top sync speeds up to 1/8000. TTL shooters rejoice! That alone is 

a game changer, but the amenities continue with the Indra500’s 

dual-power options that allow operation via its included li-ion 

battery or AC adapter, making it the perfect light for location 

and studio use. I call that a win-win. 

Video lights for on-camera use with a color rendering index (CRI) 

of 98 are hard to find, but the aluminum Akurat LL2120hc3 

V-WHITE fits in the palm of your hand, provides high brightness, 

has excellent build quality, and includes two white balance set-

tings, all at a low price. 

The V-WHITE video light has a CRI of 95+ (R1–R14 greater than 

95, including R9 and R12; Ra=98) and a high luminous emittance. 

You mount the 270-g lamp on a camera or tripod with the hot-

shoe adapter or the 1/4" mount, and adjust the light direction 

with a traditional yoke. The light bundle extends to a 120° angle, 

which is sufficient to fill the whole frame.

I tested the LL2120hc3 V-WHITE with a spectrophotometer at 

a distance of 50 cm, revealing the following values: Lowest dim 

setting—30 lx at 5770K; halfway setting—470 lx at 5800K; and 

full setting—850 lx at 5800K.

In a second test, I shot an object at one meter with a LumoPro 

LP180 flash set at 1/128 and zoom factor 50mm, followed by the 

LL2120hc3 V-WHITE at its highest setting. The camera was fixed 

at 1/125 and f/2.8. The V-WHITE proved to be useful as a continu-

New hardware is always great, but it can be tough to choose the 

right laptop when you need a lot of power on the road. If you 

prefer a Windows platform, the HP ZBook 15 G2 is an excellent 

choice, plus it offers connectivity options that are out of this world.

Under the Windows 7 Professional 64 OS (and a Windows 

8.1 Pro license), the ZBook 15 G2 (tested) gets its faster-than-a- 

speeding-bullet superpowers from an Intel Core i7-4810MQ pro-

cessor with Intel HD Graphics 4600 (2.8 GHz, up to 3.8 GHz with 

Intel Turbo Boost Technology), 6-MB cache, and vPro technology. 

The more-than-capable NVIDIA Quadro K2100M, 2-GB graphics 

card, along with 16 GB of RAM may not give you x-ray vision, but 

the 720p, HD video conferencing camera is sharp and works well, 

even in low lighting. The DTS audio is respectable for a laptop, 

and external speakers (or headphones) sound great. HP also offers 

video and audio expansion options. 

For connectivity, the HP ZBook 15 G2 offers a complete range 

of ports, including three USB 3 (with one charging port); one  

USB 2; one Thunderbolt 2 (for the ultimate in throughput and hub 

options); one DisplayPort 1.2; an optional second battery bay; and 

For larger studio lights, Rosco’s eight 12x12" Filter Kits are the 

ticket. Use the Color Correction kit to balance studio lights on 

location; soften, sculpt, and texture light with the Diffusion kit; 

or use the Cinegel Sampler kit for a blend of color correction and 

diffusion options. Add vibrant contrasting colors using the Color 

Effects kit; produce primary and secondary lighting effects with 

the CalColor kit; and take your night photography to the next 

level with the Digital After Dark kit. Choose from the Beauty kit’s 

hand-selected filters to enhance skin tones, and get the essential 

filters every photographer needs with the Photo Lighting kit. ■

Rounding out this awesome light, additional features include 

an 8-stop power range; Manual and Stroboscopic modes; Sec-

ond Curtain Sync; ±3 EV adjustments; manual power from 1/128 

to full power in 1/3-stop increments; an LED modeling light;  

a built-in Phottix Strato II Receiver; 400 full-power shots using 

the 5000 mAh Indra battery pack; and 2-second recycle times. 

At just under 5 lbs, the Indra500 TTL Light packs a punch. ■

ous studio light (a couple of them could replace a softbox) or as an 

extra fill light when flash alone won’t cut it.

For the final test, I used the LL2120hc3 V-WHITE in a huge 

demo hall with a high ceiling. The hall was well lit with overhead 

fluorescent tubes, but this job required shooting the internal 

structure of an industrial printer. Aiming the LL2120hc3 V-WHITE 

at the printer’s insides from a distance of one meter proved the 

V-WHITE to be quite capable of overpowering the light overhead. 

For a lamp the size of your hand, that’s no small feat. ■

of course, a docking connector. Add to that the ZBook’s slots for 

ExpressCard/54, SD, and a smartcard reader, and there isn’t much 

that you can’t do with this powerful workstation. Also worth not-

ing is the excellent signal reception of its Intel Dual Band Wireless-

AC 7260 for 802.11 a/b/g/n/ac (2x2) WiFi.

The only kryptonite for the ZBook 15 G2 might be that the 

internal storage capacity of its super-speedy SSD is only 256 GB, 

which, by today’s standards, could be larger to accommodate more 

scratch disk space. For an additional $500, HP offers an optional 

version that includes both an SSD and a 1-TB, 7200-rpm drive. ■

 Phottix Indra500 TTL Light

 Akurat Lighting LL2120hc3 V-WHITE

 HP ZBook 15 G2 

Company: Akurat Lighting	 Price: $270

Web: http://akuratlighting.com	 Rating: ◆ ◆ ◆ ◆ ◆

	 Hot: High CRI; flicker-free dimming; quality build; price

	 Not: 

Company: Rosco Laboratories	 Price: �Flash Packs: $24.95;  
Filter Kits: $34.95–59.95

Web: www.rosco.com	 Rating: ◆ ◆ ◆ ◆

	 Hot: Clearly organized packs help remove the mystery

	 Not: Example photos for each gel would be helpful

 ›  ›  GET THE SCOOP ON THE LATEST GEAR

Company: Phottix	 Price: $1,295 

Web: www.phottix.com	 Rating: ◆ ◆ ◆ ◆ ◆

	 Hot: Portable; AC/DC power; TTL; HSS; Canon- and Nikon-compatible

	 Not: Adjustments in 1/10-stop increments would be nice

Company: Hewlett-Packard Development Company	 Price: $2,499 as tested

Web: www.hp.com	 Rating: ◆ ◆ ◆ ◆ ◆

	 Hot: Speed/performance; DTS audio; display quality; connectivity ports 

	 Not: SSD capacity

http://akuratlighting.com
www.rosco.com
www.phottix.com
www.hp.com
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It seems with the Creative Cloud subscription model that Pho-

toshop is almost a living creature, growing and evolving every 

few weeks. That presents problems for authors—how do you 

keep your printed book (or ePub) relevant? Obviously authors 

can’t discuss features added to the program after the book 

goes to the printer. What authors can do is produce a mas-

terful book that covers critical tasks in depth, using the most 

important and commonly used features in Photoshop. Com-

bining elements from two or more images into a single com-

posite, and having that composite look natural (or intentionally 

unnatural, such as much of the work of Jerry Uelsmann and 

John Paul Caponigro) is explored and explained in this book. 

The authors discuss (and include exercises for) photograph-

ing images you intend to composite (including lighting, back-

grounds, perspective, and scale), the critical skills of selecting 

and masking, and the art of putting the pieces together.

Yes, some parts of this book and almost all of the photo-

graphs are specific to underwater photography, but the 

author also discusses photographic topics that apply to most 

of us. The original German title of the book is Die Kunst der 

Unterwasserfotografie (The Art of Underwater Photography) 

which, when looking at the beautiful and sometimes startling 

photographs, seems to be more appropriate. But don’t worry 

about the translation of the text (by David Schlesinger)—it’s 

clear and accurate. Among the topics explained in ways that 

are not specific to underwater photography are aperture, 

shutter speed, and ISO; file formats; white balance; compo-

sition, perspective, and compositing; wide-angle and macro 

photography; and image editing. (The author considers most 

underwater photography to be documentary in nature—no 

pun intended—and therefore takes an absolute minimalist 

approach to editing.)

Underwater PhotographyPhotoshop Masking & Compositing, 2nd Edition
By Tobias FriedrichBy Katrin Eismann, Seán Duggan, James Porto

          

Publisher: New Riders	 Pages: 487  

Website: www.newriders.com  

	 Price:  $59.99		  Rating:  ◆ ◆ ◆ ◆ ◆

Publisher: Rocky Nook	 Pages: 206

Website: www.rockynook.com 

	 Price: $39.95	 Rating:  ◆ ◆ ◆ ◆ ◆

High Dynamic Range for Amateurs  
 Review by Erik Vlietinck

Compact, Handheld Camera Stabilizer  
 Review by Rod Harlan

 Photomatix Essentials 4

Photomatix Essentials 4 is an entry-level, easy-to-use, standalone 

application to create HDR images. The adjustments are basic and 

more or less limited to selecting from the presets, which range from 

natural to artistic. The app is the amateur version of Photomatix 

Pro—still by far the best HDR app on the market.

Photomatix Essentials allows you to merge to HDR and apply 

tone mapping. New features in version 4 include Exposure Fusion 

for more natural-looking images (you can automatically align hand-

held photos and remove ghosts), and Finishing Touch, which lets 

you add a bit of sharpness and has a button to start over again.

The startup screen of Photomatix Essentials 4 guides you 

through the workflow, giving you only a couple of options from 

which to choose. I tested it with three images, and opted for the full 

automatic workflow. In this mode, you can still adjust a couple of 

things, such as manual alignment, if necessary. Oddly enough, the 

startup screen doesn’t mention that there’s a limit of five photos 

you can use to create your HDR image with the Essentials version.

Photomatix Essentials lacks the ability to export true 32-bit HDR 

images, so all you can do is tone map the result to render on stan-

dard monitor screens—probably what most people will want to do. 

The Steadicam CURVE for GoPro is designed specifically for one-

handed GoPro camera shoots. Weighing in at just half a pound, 

the CURVE is the perfect companion for those looking to get Stea-

dicam’s stabilization technology in a compact package. 

The frame, made from lightweight, durable aluminum, includes 

a standard GoPro quick-release mount. The design includes a col-

lapsible handle for compact storage and portability, or for use as 

a GoPro hand grip. There’s also a fine-tune adjustment knob for 

precise balance control, and the unit comes in four colors: black, 

blue, red, and silver. 	The Steadicam CURVE works with all GoPro 

HERO cameras, but some models require the LCD BacPac or the 

Optional Curve Weight Kit ($12.95). Check out all available options 

for your particular GoPro camera on Tiffen’s Steadicam CURVE 

Compatibility Chart (www.tiffen.com/steadicam_curve_com-

patibility.html). The chart is difficult to read, and I’d prefer that 

they made something easier to understand.

Don’t expect to get perfectly smooth footage the first time 

you shoot with the Steadicam CURVE. As well as fine-tuning the 

balance, you’ll also need to get comfortable walking with bended 

knees and a lower center of gravity—this is true for all Steadicams. 

HDRsoft masters tone mapping like no other, and it’s not hard to 

quickly create a good-looking HDR image with Photomatix Essen-

tials 4. The included Fusion/Natural algorithm ensures realism for 

most HDR images, but it lacks the Fusion/Real-Estate setting for nat-

ural rendering of indoor scenes with light shining through windows.

Using Photomatix Essentials 4, you can create faux-HDR 

images from one photo, but only the tone mapping settings will 

be available. ■

One area of disappointment I came across was in relation to 

wind. Both the GoPro and the CURVE are too lightweight to han-

dle even a moderate amount of wind. For shooting on those days, 

you’ll need to find a way to block the majority of the wind from 

affecting your GoPro/CURVE setup. But even with this limitation, 

the Steadicam CURVE for GoPro is a great addition to your GoPro 

HERO camera accessory bag. ■

 Tiffen Steadicam CURVE for GoPro 

Company: The Tiffen Company 	 Price: $99.95 

Web: www.tiffen.com	 Rating: ◆ ◆ ◆ ◆

	 Hot: Steadicam’s stabilization technology in a compact size

	 Not: Doesn’t perform well in moderate wind

Company: HDRsoft	 Price: $39

Web: www.hdrsoft.com	 Rating: ◆ ◆ ◆ ◆ ◆

	 Hot: Ease of use; useful presets; excellent for beginners

	 Not: 

www.newriders.com
www.rockynook.com
www.tiffen.com/steadicam_curve_compatibility.html
www.tiffen.com/steadicam_curve_compatibility.html
www.tiffen.com
www.hdrsoft.com
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It’s that time again. You’re looking at this tips column and won-

dering if there’s anything useful for you, or maybe something 

that you don’t know yet. I guarantee there’s something in this 

issue’s tips that’s new to you and will be plenty useful. So read 

on and happy tipping. By the way, Photoshop tipping is so much 

more fun than cow tipping. (I’m in a good mood today; it could 

be that I’m at 30,000' and on my way somewhere fun, so I apol-

ogize in advance for my dry jokes.) 

Visually Changing Your Document Size
When you create a blank document and you want it to be larger 

or smaller, you can either go to Image>Image Size or you can 

do it visually onscreen. I’m sure you’ve already guessed that you 

can use the Crop tool to scale a document down, but how do 

you make a document bigger? The answer is the same: the Crop 

tool. This is useful when you’re compositing and you need more 

screen real estate to create an effect. Press C to choose the Crop 

tool, zoom out so you can see the entire document, and drag 

the crop boundary outside the image area into the canvas. Press 

Enter to apply.

Layers in the Library
If you’re on the Creative Cloud version of Photoshop, let me 

ask you a question: Are you as excited as I am about Libraries? 

Finally, we have reusable assets right at our fingertips! I use this 

feature every day. After kicking around with Libraries for a while, 

I know I can only save one layer at a time. Or can I? I could nest 

a bunch of layers into a smart object and drag the smart object 

from the document into the Libraries panel to save it, but when  

I drag that smart object into a new document, I still have to open 

the smart object to access all the layers. So, I wondered what 

would happen if I save a layer group as a Library object. Yep, 

it works! All you need to do is throw all your layers into a layer 

group (Command-G [PC: Ctrl-G]) and drag the layer group from 

the document into the Libraries panel. Now you have all those 

layers at your fingertips whenever you want them. 

Pixel-Perfect Lens Flare Placement 
Lens flares in photographs are as common as Toyota Prii in Cali-

fornia. My first subtip to warm you up is this: when using the Lens 

Flare filter, use Hue/Saturation and change the color to some-

thing different. Oh yeah, also make sure that you’re adding it to 

a backlit photo, or else it doesn’t make sense, as lens flares have 

to come directly for the light source. Okay, here’s the real tip—

getting pixel-perfect lens flare placement. In recent versions of 

Photoshop, lens flares have become easier to work with because 

you now have an image preview for placement in the Lens Flare 

dialog. But how do you get the placement exact? The first step is 

to note the coordinates where you want to place the lens flare. 

For this, choose the Info panel (Window>Info), put your cursor 

exactly where you want the flare, and take notice of the X and Y 

values. (Note: If your values aren’t set to pixels, click the disclosure 

triangle to the left of the coordinates and choose Pixels.) Step 

Two is to apply the lens flare: Filter>Render>Lens Flare. Now, hold 

down Option (PC: Alt) and click in the preview window. You’ll see 

a dialog pop up called Precise Flare Center. Type in the X and Y 

values, click OK twice, and bang! Perfect placement. 

Steal My Settings
A lot of people are aware that you can copy layer styles, layer 

masks, etc. between layers in the same document. To copy an 

asset from one layer to another, Option-drag (PC: Alt-drag) it. 

To move it, simply drag it from one layer to another. But what 

if you want to move it from one document to another? Here’s 

the scoop: You can copy layers, layer groups, smart objects, 

layer masks, layer styles, text, shapes, paths, and alpha chan-

nels from one document to another by dragging the asset from 

the Layers panel (Channels panel for alpha channels, Paths 

panel for paths) and dropping it into the middle of the other 

document. This is useful for many things, including working 

on low-res comps, then building out full-size images such as 

billboards and reusing the assets from the comps. Choosing 

Window>Arrange and selecting 2-up Vertical to view the docu-

ments side by side will help a lot. 

Help! I’m Using a Wacom Tablet and the  
Brush Options Don’t Work
There are two brush options in the Options Bar for pen pressure. 

One turns pen pressure on and off for opacity and the other 

turns pen pressure on and off for size. But what happens when 

you turn off the option for opacity in the Options Bar, and it 

seems that the opacity is still being controlled by pen pressure?  

Is it broken? Hold that call to tech support; here’s how it works. 

If the brush preset has pen pressure turned on for opacity or size, 

clicking the icons in the Options Bar to turn off pen pressure will 

make no difference. If you want to control it from the Options 

Bar, open the Brush panel (Window>Brush), and turn off the 

pen pressure options for size and opacity in the Shape Dynamics 

and Transfer sections. Now, click the little padlocks to the right 

of Shape Dynamics and Transfer to lock these options. You can 

now control them from the Options Bar. Just remember if you 

want to change things like angle, these options will need to be 

turned back on in the Brush panel. This is a good workflow for 

retouchers; not so much for digital painters.

Changing the Duration of Motion Graphics
When working with motion graphics or adjustment layers in 

the Timeline panel, you’ll notice that these objects are displayed 

as purple bars. These are added on the timeline wherever the 

playhead is at the time of creation. It’s easy to change their 

position or duration. To change position, click-and-drag them 

to a different location on the timeline. The duration is just as 

easy: click-and-drag the beginning or the end to stretch or 

shrink the duration. 

Cleaning Up Your Desk
If you’re the kind of person who’s told repeatedly by your boss 

to clean up your desk, perhaps you think you thrive in chaos.  

If that’s the case, I imagine you have a million icons on your 

computer desktop and your panels are everywhere in Photo-

shop. Every time you want to do something in Photoshop, you 

have to drag a panel out of the way. Guilty? Sorry, I can’t help 

with your desk or icon problem, but I can help with your panels 

and Photoshop layout. The first thing you need to do is set aside  

10 minutes and create some workspaces. Open the panels that 

you want to use and position them, and close all the panels 

that you don’t need. At the far right of the Options Bar, click 

on the workspace drop-down menu, select New Workspace, 

name it, and click Save. Rinse and repeat as many times as 

you need for different workspaces. This is where it gets good. 

When you see a lot of clutter, choose Reset [name of work-

space] from that same drop-down menu and bing! Instant 

cleanliness. You can even go to Edit>Keyboard Shortcuts, cre-

ate a keyboard shortcut for Reset Essentials under Window in 

the Application Menu Commands, and it will work on all work-

spaces. I use Command-Shift-Option-C (PC: Ctrl-Shift-Alt-C) 

because I don’t really need a shortcut for Edit>Content-Aware 

Scale anyway. Now, if I could just find the keyboard shortcut to 

clean my room.

Layer Styles, to Scale or not to Scale?
You may or may not be aware of this but when you transform 

the size of an object that has a layer style attached to it, the 

object will scale, but the layer style will stubbornly keep its set-

tings and not scale with everything else. For example, if you have 

a 5-px bevel on an edge, it will stay at 5 px no matter how large 

or small you make your object. If you want the layer style to 

scale with the object, it’s really quite simple. Simply Right-click on 

the layer name in the Layers panel and choose Convert to Smart 

Object. Now that you have a smart object, the layer style will 

happily scale with everything else now. ■

D E PA R T M E N T  › › › › P H O T O S H O P  T I P S

Photoshop Tips
  boost your productivity and creativity COLIN SMITH
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To: Vanessa
From: KelbyOne Help Desk

Photoshop automatically creates tabbed image windows 

when multiple files are open. The tabs align along the 

top of the work area and only one image can be visible 

at a time. To see more than one image at a time, drag a 

tab away from the top of the work area to “float” the 

window, use one of the Window>Arrange commands 

to tile or float images, or you can disable the feature 

completely in the Preferences.

Command-K (PC: Ctrl-K) is the shortcut to open the 

Preferences dialog. Tabbed image windows are disabled 

in the Interface panel of the Preferences (where you can 

also disable the option to create tabbed images acciden-

tally when dragging windows around—deselect Enable 

Floating Document Window Docking). While Photoshop 

has dozens of options in the various Preferences panels, 

below are some that I consider most important.

In the General panel, activate the History Log and 

record the detailed log to the file’s metadata. In File>File 

Info or in Bridge you can then see a record of everything 

you’ve done to that file.

In the Interface panel, in addition to disabling tabbed 

image windows, you can change the font size for the 

user interface (UI), making it larger for big monitors and 

tiny for smaller screens. And if you don’t like seeing the 

transformation values (the small box to the upper right 

of the cursor as you drag things around), you can set it 

to Never.

If you use Photoshop on multiple machines, you can 

elect to sync various things (or nothing) through the Cre-

ative Cloud in the Sync Settings panel.

From The Help Desk 
	

›  ›

The KelbyOne Member  
	 HELP DESKS 

Are you taking advantage of the Help Desks at the KelbyOne member website? This is the place where you can get all of your 

Photoshop and Lightroom questions answered either by other KelbyOne members or by our Help Desk experts. Not only that, you 

can get photo and computer gear help and advice, as well. What are you waiting for? Visit the Community section on the 

KelbyOne member site today! ■

The File Handling panel offers quite a few options, 

including direct access to the Camera Raw Preferences 

and options for how often to auto-save your work.

The Performance panel is the place to fiddle with 

graphics processor settings if you’re having display prob-

lems. (No problems? Don’t change any graphic processor 

options.) I also visit this panel to change the image cache 

from the default of 4 to 1 so I’m always looking at the 

actual pixels rather than a cached approximation.

If you have more than one internal hard drive, you can 

use the Scratch Disks panel to set the second drive as the 

primary scratch disk to speed things up a bit. (Use only 

internal drives for scratch disks.)

In the Cursors panel, I like to show a crosshair in the 

brush tip so that when I’m zoomed in really far, I still 

know where my brush is working.

In Transparency & Gamut, you might want to change 

the grid colors if you work with a lot of grayscale images.

Rather than changing measurement units in the Units &  

Rulers panel, I show the rulers (Command-R [PC: Ctrl-R]) 

in the document, then Right-click on a Ruler to pick a unit.

Working with the grid and smart guides helps make 

sure your layout is precise. Set the appearance and grid 

line frequency in Guides, Grid & Slices.

In the Plug-Ins panel, you can enable Generator if you 

create Web graphics. You can also opt to show all the 

Filter Gallery filters in the main Filter menu.

Among the remaining Preferences, Windows 8 

users might want to scale the UI to 200% in Experi-

mental Features. ■   

I recently complained about being forced to use tabs when multiple images are open in Photo-
shop and a colleague suggested that I disable that feature in the program’s Preferences. How do 
I do that?—Vanessa

C O L U M N  › ›
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